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Using This Manual

What’s In This Manual

The Airpak Tutorial Guide contains a number of tutorials that teach you how to use
Airpak to solve different types of problems. In each tutorial, features related to problem
setup and postprocessing are demonstrated.

Tutorial 1 is a detailed tutorial designed to introduce the beginner to Airpak. This
tutorial provides explicit instructions for all steps in the problem setup, solution, and
postprocessing. The remaining tutorials assume that you have read or solved Tutorial 1,
or that you are already familiar with Airpak and its interface. In these tutorials, some
steps will not be shown explicitly.

How To Use This Manual

If you are a first-time user of Airpak you should first read and run Tutorial 1, in order
to familiarize yourself with the interface and with basic setup and solution procedures.
You may then want to try a tutorial that demonstrates features that you are going to
use in your application. For example, if you are planning to solve a problem involving
laboratory ventilation, you should look at Tutorial 2.

You may also want to refer to other tutorials for instructions on using specific features,
such as grouping objects, even if the problem solved in the tutorial is not of particular
interest to you.

Typographical Conventions Used In This Manual

Several typographical conventions are used in this manual’s text to facilitate your learning
process.

• An exclamation point (!) in the margin marks an important note or warning.

• Different type styles are used to indicate graphical user interface menu items and
text inputs that you enter (e.g., New project panel, enter the name /jobname).

• Instructions for performing each step in a tutorial will appear in standard type.
Additional information about a step in a tutorial appears in italicized type.
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• A mini flow chart is used to indicate the menu selections that lead you to a specific
panel. For example,

View−→Summary (HTML)

indicates that the Summary option can be selected from the View menu at the top
of the Airpak main window.

The arrow points from a specific menu toward the item you should select from that
menu.

Mouse Conventions Used In This Manual

The default mouse buttons used to manipulate your model in the graphics window are
described in the Airpak User’s Guide. See Section 2.2.4 for details. Although you can
change the mouse controls in Airpak to suit your preferences, this manual assumes that
you are using the default settings for the mouse controls. If you change the default mouse
controls, you will need to use the mouse buttons you have specified instead of the mouse
buttons that the manual tells you to use.

Where to Find the Files Used in the Tutorials

You can find job directories for the tutorials in

AIRPAK ROOT/tutorials/

where you must replace AIRPAK ROOT by the full pathname of the directory where
Airpak is installed on your computer system.

It is recommended that you copy the desired job directory (and its contents) to your local
directory. Once you have copied the job directory (e.g., office) to your local directory,
you can read the job into Airpak using the New project panel. See Section 6.2.2 of the
User’s Guide for details about reading a job into Airpak.

Since a solution dataset is included in each job, you can look at the results of the tutorial
immediately, without waiting for the calculation to finish. You can read in the associ-
ated job (which includes the solution data) before following the tutorial instructions for
examining the results.

When To Call Your Airpak Support Engineer

The Airpak support engineers can help you to plan your modeling projects and to over-
come any difficulties you encounter while using Airpak. If you encounter difficulties we
invite you to call your support engineer for assistance. However, there are a few things
that we encourage you to do before calling:
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• Read the section(s) of the manual containing information on the options you are
trying to use.

• Recall the exact steps you were following that led up to and caused the problem.

• Write down the exact error message that appeared, if any.

• For particularly difficult problems, package up the job in which the problem oc-
curred (see the User’s Guide for instructions) and send it to your support engineer.
This is the best source that we can use to reproduce the problem and thereby help
to identify the cause.

c© Fluent Inc. May 16, 2007 UTM-3



Using This Manual

UTM-4 c© Fluent Inc. May 16, 2007



Contents

1 Office Ventilation 1-1

2 Laboratory Exhaust 2-1

3 Copy Machine Emitting Volatile Gases 3-1

4 Room and Office Space Created from Imported IGES Geometry 4-1

5 High Density Datacenter Cooling 5-1

c© Fluent Inc. May 16, 2007 TOC-1



Contents

TOC-2 c© Fluent Inc. May 16, 2007



Tutorial 1. Office Ventilation

Introduction: This tutorial demonstrates how to model an office shared by two people
working at computers, using Airpak.

In this tutorial, you will learn how to:

• Open a new job

• Include effects of relative humidity distribution in the simulation

• Create blocks, openings, vents, partitions and walls

• Model the effects of radiation

• Change the number of solver iterations

• Calculate a solution

• Examine contours and vectors on object faces and cross-sections of the model

• Trace particle streams from air inlets

• Examine the comfort level in the room by calculating the predicted mean vote
(PMV) and predicted percentage dissatisfied (PPD)

Prerequisites: This tutorial assumes that you have little experience with Airpak, but
that you are generally familiar with the interface. If you are not, please review the
sample session in Chapter 1 of the User’s Guide.

Problem Description: The office is partitioned into two sections, each containing one
person working at a computer, as shown in Figure 1.1. The office also includes six
fluorescent lights, a baseboard heater, an inlet diffuser, a ventilation return, and
a window. Surface temperatures and air velocity profiles are sought in order to
determine the overall comfort of the room for its occupants.

Table 1.0.1: Geometrical, Thermal, and Flow Boundary Conditions for the Diffuser and
Window

Size Temperature Velocity
Inlet Diffuser 0.2 m × 0.3 m 13.5◦C 0.85 m/s

Window 3.65 m × 1.16 m 30.9◦C —–
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Table 1.0.2: Size and Capacity of the Heat Sources

Heat Source Size Power
Baseboard Heater 1.2m × 0.1 m × 0.2 m 1500 W

Person 0.4 m × 0.35 m × 1.1 m 75 W
Computer 1 0.4 m × 0.4 m × 0.4 m 108 W
Computer 2 0.4 m × 0.4 m × 0.4 m 173 W

Lamp 0.2 m × 1.2 m × 0.15 m 34 W

Figure 1.1: Geometry of the Office Ventilation Problem
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Step 1: Open and Define a New Job

1. Start Airpak, as described in Section 1.5 of the User’s Guide.

When Airpak starts, the New/existing panel will open automatically.

2. Click New in the New/existing panel to start a new Airpak project.

The New project panel will appear.

(a) Specify a name for your project in the Project text box.

You can enter the name office.

(b) Click Create.

Airpak will create a default room with dimensions 10 m × 3 m × 10 m, and display
the room in the graphics display window.

You can rotate the room around a central point using the left mouse button, or you
can translate it to any point on the screen using the middle mouse button. You can
zoom into and out from the room using the right mouse button. To restore the room
to its default orientation, click on the Orient menu and select Home position.

3. Modify the overall problem definition to include the effects of chemical species
mixing and turn on the ideal gas las.

Problem setup−→ Basic parameters
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(a) In the Basic parameters panel, select On next to Species and click Edit.

Airpak will open the Species definitions panel.

i. Select the Initial concentration of h2o to 50.

ii. Select RH from the menu to the right of the Initial concentration field for
h2o.

RH is the relative humidity of the air in the room specified as a percentage.

iii. Click Accept

(b) In the Basic parameters panel, click the Advanced tab.

i. Turn on the Ideal gas law option and the Operating density operation and
keep the default values for the operating pressure and density.

ii. Click Accept
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(c) Keep the default settings for all other parameters in the Basic parameters panel.

(d) Click Accept to save the new settings.
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Step 2: Build the Model
To build the model, you will first resize the room to its proper size. Then you will create
the features of the room, including people (2), computers (2), lights (6), tables (2), a
ventilation return and input diffuser, a radiator, a partition, and walls.

1. Resize the default room.

Model−→Room

(a) In the Room panel, enter the coordinates as shown in the following figure.

(b) Click Done to resize the room.

(c) Click from the Orient toolbar to show an isometric view of the room
scaled to fit the graphics window.

Note: The walls of the room are adiabatic and do not participate in radiation, by
default. To include radiation effects at the boundaries of the room, you will
define wall objects at the boundaries later in this step.

2. Create the first person in the workspace.
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Note: There is a Person object in Airpak; however, for this simulation, the repre-
sentation of the people will be simplified, i.e., the people will be represented by
hollow blocks that are energy sources. Tutorials 2 and 3 will make use of the
Person object.

(a) Click in the object toolbar.

Airpak will create a new hollow prism block in the center of the room. You will
need to change both the size of the block and its location within the room.

(b) Display the Blocks edit panel by doing one of the following:

• Double click block.1 in the Model manager window.

• Select block.1 in the Model manager window and right mouse click to
display the context menu. Select Edit object.

(c) Enter the following coordinates for the first person in the Geometry tab:

xS 1.4 xE 1.8

yS 0 yE 1.1

zS -0.6 zE -0.95

(d) In the Properties tab, set the Total power under Thermal specification to be 75

W.

(e) In the Info tab, enter the name person1 in the Name field.

(f) Click Update to modify the block. Click Done to close the panel.

3. Create the second person.

(a) Click in the object toolbar.

(b) Double click block.1 in the Model manager window to display the Blocks edit
panel.

(c) In the Geometry tab, enter the following coordinates for the second person:

xS 3.6 xE 4.0

yS 0 yE 1.1

zS -3.05 zE -3.40

(d) In the Properties tab, set the Total power under Thermal Specification to be 75

W.

(e) In the Info tab, enter the name person2 in the Name field.

(f) Click Done to update the block and close the panel.

4. Create the first computer.

The computers will be represented by hollow blocks in front of the people in the
office.
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(a) Click in the object toolbar.

(b) Double click block.1 in the Model manager window to display the Blocks edit
panel.

(c) Enter the following coordinates for the first computer:

xS 1.4 xE 1.8

yS 0.7 yE 1.1

zS 0 zE -0.4

(d) In the Properties tab, set the Total power under Thermal Specification to be
108 W.

(e) In the Info tab, enter the name computer1 in the Name field.

(f) Click Done to update the block and close the panel.

5. Create the second computer.

(a) Click in the object toolbar.

(b) Double click block.1 in the Model manager window to display the Blocks edit
panel.

(c) Enter the following coordinates for the second computer:

xS 3.6 xE 4.0

yS 0.7 yE 1.1

zS -3.6 zE -4.0

(d) In the Properties tab, set the Total power under Thermal Specification to be
173 W.

(e) In the Info tab, enter the name computer2 in the Name field.

(f) Click Done to update the block and close the panel.

6. Create the radiator.

This baseboard heater is the largest heat source in the room, and its represented in
the simulation by a hollow prism block.

(a) Click in the object toolbar.

(b) Double click block.1 in the Model manager window to display the Blocks edit
panel.

(c) Enter the following coordinates:

xS 0 xE 0.1

yS 0 yE 0.2

zS -1.4 zE -2.6
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(d) In the Properties tab, set the Total power under Thermal Specification to be
1500 W.

(e) In the Info tab, enter the name baseboard-heater in the Name field.

(f) Click Done to update the block and close the panel.

7. Create the first overhead fluorescent lamp.

(a) Click in the object toolbar.

(b) Double click block.1 in the Model manager window to display the Blocks edit
panel.

(c) Enter the following coordinates:

xS 1.1 xE 1.3

yS 2.85 yE 3.0

zS -0.5 zE -1.7

(d) In the Properties tab, set the Total power under Thermal Specification to be 34

W.

(e) In the Info tab, enter the name lamp in the Name field.

(f) Click Done to update the block and close the panel.

8. Copy the first lamp (lamp) to create the second and third lamps (lamp.1 and lamp.2),
each offset by 1.3 m in the x direction.

(a) In the Model manager window, select lamp.

(b) Right mouse click to display the context menu.

(c) Click copy.

The Copy block lamp panel will open.
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(d) Enter 2 as the Number of copies.

(e) Turn on the Translate option and specify an X offset of 1.3.

(f) Click Apply.

Airpak will create two copies of the original lamp, each offset from the previous
one by 1.3 m in the x direction.

9. Create the remaining three overhead lamps.

(a) Create a group consisting of the three existing lamps.
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i. Select lamp in the Model manager window, hold down the <Ctrl> key and
click on lamp.1 and lamp.2 to select or highlight all three lamps.

ii. Right mouse click to display the context menu and select Create group.

iii. In the Query panel, enter lamp as the name for the new group.

iv. Click Done.

lamp, lamp.1 and lamp.2 will be added as a group under the Groups node in the
Model manager window.

(b) Make a copy of this group.

i. Select the Groups node in the Model manager window and expand the
Groups tab.

ii. Select the lamp group and right mouse click to display the context menu.

iii. Select Copy group to display the Copy group lamp panel.

iv. Enter 1 as the Number of copies.

v. Turn on the Translate option.

vi. Set the X offset and Y offset to 0, set the Z offset to -1.8.

vii. Click Apply

The display will be updated to show all six lamps.

10. Create the air inlet diffuser.

(a) Click icon in the object toolbar.

Airpak will create a 2D opening in the center of the room. You will need to
change the size and orientation of the opening and specify the temperature and
air flow information.

(b) Double click opening.1 in the Model manager window to display the Openings
edit panel.

(c) In the Geometry tab, change the plane to Y-Z and enter the following coordi-
nates for the opening:

xS 5.0 xE ---

yS 2.7 yE 2.9

zS -1.85 zE -2.15

(d) In the Properties tab, select Temperature and enter a value of 13.5◦C.

(e) Select X Velocity and enter a value of -0.85 m/s.

(f) Select Species and click Edit.

Airpak will open the Species concentrations panel.
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i. In the Species concentrations panel, enter a value of 50 for the Concentra-
tion of h2o.

ii. Select RH from the menu to the right of the Concentration field for h2o.

iii. Click Done to update the opening and close the panel.

iv. In the Info tab of the Openings panel, enter the name air-inlet in the
Name field.

v. Click Done to update the opening and close the Openings panel.

11. Create the ventilation return.

(a) Click the icon in the object toolbar.

(b) Double click vent.1 in the Model manager window to display the Vents edit
panel.

(c) In the Geometry tab, change the plane to Y-Z and enter the following coordi-
nates for the vent:

xS 5.0 xE ---

yS 0 yE 0.5

zS -1.75 zE -2.25

(d) In the Properties tab, select Approach for the Velocity loss coefficient.
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(e) In the Info tab, enter the name vent-return in the Name field.

(f) Click Done to update the vent and close the Vents panel.

12. Create the office partition.

(a) Click the icon in the object toolbar.

(b) Double click partition.1 in the Model manager window to display the Partitions
edit panel.

(c) In the Geometry tab, change the plane to Y-Z and enter the following coordi-
nates for the partition:
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xS 2.87 xE ---

yS 0 yE 3.0

zS -2.0 zE -4.0

(d) In the Info tab, enter the name partition in the Name field.

(e) Click Update in the Partitions panel to modify the partition.

13. Create the first office table.

(a) Click the icon in the object toolbar.

(b) Double click partition.1 in the Model manager window to display the Partitions
edit panel.

(c) In the Geometry tab, change the plane to X-Z and enter the following coordi-
nates:

xS 3.0 xE 5.0

yS 0.6 yE ---

zS -3.524 zE -4.0

(d) In the Info tab, enter the name table in the Name field.

(e) Click Done to update the table and close the Partitions panel.

14. Copy the first table to create the second (table.1).

The second table will be offset from the first table by 3 m in the x direction and
3.524 m in the z direction.

(a) In the Model manager window, select table.

(b) Right mouse click to display the context menu.

(c) Click copy.

The Copy partition table panel will open.

(d) Turn on the Translate option and specify an X offset of -3 m and a Z offset of
3.524 m.

(e) Click Apply to copy the table and close the panel.

15. Create the office window.

(a) Click the icon in the object toolbar.

Airpak will create a wall in the center of the room. You will need to change
the size and orientation of the wall and specify the temperature and radiation
parameters.

(b) Double click wall.1 in the Model manager window to display the Walls edit
panel.

(c) In the Geometry tab, change the plane to Y-Z and enter the following coordi-
nates for the window:
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xS 0 xE ---

yS 1.671 yE 2.831

zS -0.203 zE -3.853

(d) In the Properties tab, select Outside temp and enter a value of 30.9◦C.

(e) In the Info tab, enter the name window in the Name field.

(f) Click Done to update the window and close the Walls panel.

16. Create the floor for the room.

(a) Click the icon in the object toolbar.

(b) Double click wall.1 in the Model manager window to display the Walls edit
panel.

(c) In the Geometry tab, change the plane to X-Z and enter the following coordi-
nates for the floor:

xS 0 xE 5.0

yS 0 yE --

zS 0 zE -4.0

(d) In the Info tab, enter the name floor in the Name field.

(e) Click Done to update the window and close the Walls panel.

17. Create the left wall of the room.

(a) Click the icon in the object toolbar.

(b) Double click wall.1 in the Model manager window to display the Walls edit
panel.

(c) In the Geometry tab, use the default plane of X-Y and enter the following
coordinates:

xS 0 xE 5.0

yS 0 yE 3.0

zS 0 zE ---

(d) In the Info tab, enter the name wall-left in the Name field.

(e) Click Done to update the window and close the Walls panel.

18. Create the back wall of the room.

(a) Click the icon in the object toolbar.

(b) Double click wall.1 in the Model manager window to display the Walls edit
panel.

(c) In the Geometry tab, change the plane to Y-Z and enter the following coordi-
nates:
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xS 0 xE ---

yS 0 yE 3.0

zS 0 zE -4.0

(d) In the Info tab, enter the name wall-back in the Name field.

(e) Click Done to update the window and close the Walls panel.

19. Copy the floor to create the ceiling.

(a) In the Model manager window, select floor.

(b) Right mouse click to display the context menu.

(c) Click copy.

The Copy wall floor panel will open.

(d) Turn on the Translate option and specify an X offset of 0 m, a Y offset of 3 m
and a Z offset of 0 m.

(e) Click Apply.

Airpak will create a copy of the floor (floor.1) on the top of the room.

(f) Select floor.1 in the Model manager window.

(g) In the Name field located in the Info tab, change floor.1 to ceiling.

(h) Click Done to update and close the panel.

20. Copy the left wall to create the right wall.

(a) Select wall-left in the Model manager window.

(b) Right mouse click and select Copy object from the context menu.

The Copy wall-left panel will open.

(c) Turn on the Translate option.

(d) Specify an X offset of 0, Y offset of 0, and a Z offset of -4.

(e) Click Apply.

Airpak will create a copy of the left wall (wall-left.1) on the right of the room.

(f) Select wall-left.1 in the Model manager window.

(g) In the Info tab, change wall-left.1 to wall-right in the Name field.

(h) Click Done to update the wall.

21. Copy the back wall to create the front wall.

(a) Select wall-back in the Model manager window.

(b) Click Copy object from the context menu.

The Copy wall-back panel will open.
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(c) Keep the Translation option turned on.

(d) Specify an X offset of 5, a Y offset of 0, and a Z offset of 0.

(e) Click Apply.

Airpak will create a copy of the back wall (wall-back.1) on the front of the room.

(f) Select wall-back.1 in the Model manager window.

(g) In the Info tab, change wall-back.1 to wall-front in the Name field.

(h) Click Done to update and close the panel.

The completed model will look like Figure 1.2.

Figure 1.2: Completed Model for the Office Ventilation Simulation
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22. Check the model to be sure that there are no problems (e.g., objects that are too
close together to allow for proper mesh generation).

Model−→Check model

Airpak should report in the Message window that 0 problems were found and all
tolerances are acceptable.

23. Check the definition of the modeling objects to ensure that you specified them
properly.

View−→Summary(HTML)

Airpak will list the specifications for all modeling objects in a web browser which
can be launched from selecting the View menu and clicking Summary(HTML) . You
can check them here and if you notice any incorrect specifications, you can change
them in the object’s edit panel.
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Step 3: Add Radiation to the Model
In this step, you will include the effects of radiation in your model.

1. Enable radiation modeling.

Model−→Radiation

(a) Under the Radiation enabled list, click All to select all of the objects in the
room.

(b) At the bottom of the panel, select 1 from the menu to the right of the Ref
level.

The smaller the Ref level value, the faster Airpak will compute the view factors.

(c) Click Compute.

Airpak will compute the form factors for the selected objects. See the User’s
Guide for details about modeling radiation.

Note: It will take several minutes for Airpak to complete the radiation calcu-
lations. The Message window will report when it is Done computing form
factors.

(d) Click Close.
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Step 4: Generate a Mesh
You will generate the mesh in three steps. First you will modify the order in which
objects are meshed. Then you will create a coarse mesh and examine it to determine
where further mesh refinement is required. Finally, you will refine the mesh based on
your observations of the coarse mesh.

1. Change the mesh priority of the room walls.

You will need to change the order in which the objects in the room are meshed so
that room objects in contact with the walls will receive a higher priority than the
walls in the meshing process.

Model−→Edit priorities

(a) In the Object priority panel, enter a value of 0 for floor, ceiling, wall-left, wall-
right, wall-back, and wall-front.

(b) Click Accept to modify the priorities and close the panel.
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Figure 1.3: Object Priority Panel
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2. Generate a coarse (minimum-count) mesh.

Model−→Generate Mesh

(a) In the Global settings section in Mesh control panel, select Coarse in the Mesh
parameters drop-down list.

Airpak will update the panel with the default meshing parameters for a coarse
(minimum-count) mesh, shown in the panel below.

Figure 1.4: Mesh Control Panel
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(b) Deselect Max X size, Max Y size, and Max Z size.

(c) Click the Generate mesh button to generate the coarse mesh.

3. Examine the coarse mesh on a cross-section of the model.

(a) Select the Display tab at the top of the Mesh control panel.

(b) Turn on the Cut plane option.

(c) Select Point and normal from the drop down list across from Set position.

(d) Set (PX,PY,PZ) to (2,0,0) and set (NX,NY,NZ) to (1,0,0).

These settings will result in a mesh display on a y-z plane passing through the
point (2,0,0).

Figure 1.5: Display Tab of the Mesh Control Panel
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(e) Turn on the Display mesh option.

The mesh display plane is perpendicular to the ceiling, and aligned with the
people, computers, and tables as shown in Figure 1.6.

(f) Click on the two square boxes to advance the plane cut through the model.

Figure 1.6: Coarse Mesh on the y-z Plane

4. Generate a finer mesh.

(a) Select the Generate tab at the top of the Mesh control panel.

The panel will be update to show the mesh generation tools again.

(b) Select Normal in the Mesh parameters drop-down list.

Airpak will update the panel with the default meshing parameters for a “nor-
mal” (i.e., finer than coarse) mesh.

(c) Turn on Max X size, Max Y size, and Max Z size, and set each of them to 0.3.

(d) Change the Max O-grid height to 0.001.

This will restrict the tendency of the meshing algorithm to wrap O-grid type
meshes around objects.

(e) Select Object params and click Edit.

Airpak will open the Per-object mesh parameters panel.
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(f) Set object-specific meshing parameters for the air-inlet opening.

i. In the Per-object mesh parameters panel, highlight air-inlet.

Airpak will display the object-specific meshing parameters for the opening.

ii. Select Y count and Z count.

iii. Under Requested, enter 5 for Y count and Z count.

iv. Click Done to save the settings and close the panel.

air-inlet will be displayed in red to indicate that meshing parameters have
been set for this object.

(g) Click the Generate Mesh button in the Mesh control panel to generate a finer
mesh.

5. Examine the new mesh.

The graphics display will be updated automatically to show the new mesh (Fig-
ure 1.7). You can move the two square boxes in the Display section of the Mesh
control panel to advance the plane cut and view the mesh throughout the model.
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Figure 1.7: Fine Mesh on the y-z Plane
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6. Turn off the mesh display.

(a) Select the Display tab at the top of the Mesh control panel.

(b) Deselect the Display mesh option.

(c) Click Close to close the Mesh control panel.
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Step 5: Check the Flow Regime
Before starting the solver, you will first review estimates of the Reynolds and Peclet
numbers to check that the proper flow regime is being modeled.

1. Check the values of the Reynolds and Peclet numbers.

Solve−→Settings−→Basic

(a) Click the Reset button.

(b) Check the values printed to the Message window.

The Reynolds and Peclet numbers are approximately 12000 and 9000, respec-
tively, so the flow is turbulent. Since you are currently modeling turbulent
flow,no changes are required. The Message window will also report that the
initial air velocity has been reset to −10−4 times gravity. This modification
improves the convergence of natural convection calculations.

(c) Click Accept to save the new solver settings.
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Step 6: Save the Model to a Job File
Airpak will save the model for you automatically before it starts the calculation, but it is
a good idea to save the model (including the mesh) yourself as well. If you exit Airpak
before you start the calculation, you will be able to open the job you saved and continue
your analysis in a future Airpak session. (If you start the calculation in the current Airpak
session, Airpak will simply overwrite your job file when it saves the model.)

File−→Save Project

Step 7: Calculate a Solution

1. Increase the Number of iterations to 1000.

Solve−→Settings−→Basic
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2. Modify the parameters for the solver.

Solve−→Settings−→Advanced

(a) In the Advanced solver setup panel, enter the following values for Under-relaxation:

• Pressure: 0.7

• Momentum: 0.3

• Retain the defaults for Temperature, Viscosity, Body forces, and h2o.

Occasionally, for low ventilation flow rates, it may be necessary to adjust the
under-relaxation factors for Pressure and Momentum to 0.7 and 0.3, respec-
tively, so that the calculation will converge more easily. Low flow rates in this
tutorial require such changes in these factors.

(b) Click Accept to store the settings and close the Advanced solver setup panel.

3. Start the calculation.

Solve−→Run Solution

(a) Keep the default settings in the Solve panel.

(b) Click Start solution to start the solver.
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Figure 1.8: Solve Panel
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Airpak will begin to calculate a solution for the model, and a separate window
will open where the solver will print the numerical values of the residuals.
Airpak will also open the Monitor graphics display and control window, where
it will display the convergence history for the calculation.

If you do not want to wait for the calculation to finish, you can save time by
reading in the results provided in the tutorials directory and then following
the instructions (in the next step of this tutorial) for examining the results.
See the preface (Using This Manual) for details.

Upon completion of the calculation, your residual plot will look similar to
Figure 1.9. Note that the actual values of the residuals may differ slightly on
different machines, so your plot may not look exactly the same as Figure 1.9. In
the window where the residual values are printed, the calculation will continue
after the residual plot stops, as the equations for radiation and mean age of
air are solved.

To get a more accurate solution, it may be necessary to continue the calcula-
tion until all residual plots level off. You can do this by reducing the conver-
gence criteria for the flow and energy equations in the Solver setup panel and
restarting the calculation. See the User’s Guide for details about restarting
the calculation from an existing solution.

4. When the solution is completed, as in Figure 1.9, close the Monitor window by
clicking Done.
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Figure 1.9: Residuals
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Step 8: Examine the Results
The objective of this exercise is to consider the airflow patterns through out the office and
the heat dissipation of the energy sources in the room. You will also examine the comfort
level of the room. You will accomplish this by examining the solution using Airpak’s
graphical postprocessing tools.

1. Display velocity vectors on a horizontal plane cut through the office.

Post−→Plane cut

Figure 1.10: Plane Cut Panel

(a) In the Info tab, enter the name velocity-vectors in the Name field.

(b) Keep the default selection of Point and normal for the plane specification.

(c) Specify the point (PX,PY,PZ) as (0,2.55,-2), and the normal (NX,NY,NZ)
as (0,1,0).

This defines a cross-section in the x-z plane, passing through the point (0,2.55,-
2).

(d) Select Show vectors.

(e) Click Create.

(f) Click on the Orient menu and select Positive Y.

This will orient the model as shown in Figure 1.11. You can see the flow
distribution of low-velocity ventilation air throughout the office on this plane.

You can use the slider bar under Set plane in the Plane cut panel to move the
vector plane through the model.

(g) In the Plane cut panel, turn off the Active option and click Update.

This will temporarily remove the velocity vector display from the graphics win-
dow, so that you can more easily view the next postprocessing object.
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Figure 1.11: Velocity Vectors in an x-z Cross Section

Hint: If the Plane cut panel is not visible on your screen, select velocity-vectors
in the Post objects list in the postprocessing Edit panel to bring the Plane
cut panel to the foreground.
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2. Display the mean age of the air in the office.

(a) Click New in the Plane cut panel.

(b) In the Info tab, enter the name mean-age-air in the Name field.

(c) Select Point and normal for the plane specification.

(d) Specify the point (PX,PY,PZ) as (0,2,0), and the normal (NX,NY,NZ) as
(0,1,0).

This defines a cross-section in the x-z plane, passing through the point (0,2,0).

(e) Select Show contours and click Parameters.

The Plane cut contours panel will open.

(f) Select Mean age of air in the drop-down list.

Figure 1.12: Plane Cut Contours Panel
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(g) Click Done to update the graphics display and close the panel.

(h) Click on the Orient menu and select Isometric view.

The graphics display will be updated to show the mean age of air contour plot,
as shown in Figure 1.13.

Figure 1.13: Mean Age of Air Contours

(i) In the Plane cut panel, turn off the Active option and click Done.

3. Display contours of temperature on the block surfaces in the office.

Post−→Object face

(a) In the Face name field, enter the name temp-contours.

(b) In the Object drop down list, select all block objects using the <Ctrl> key and
the left mouse button. Click Accept.

(c) Keep the default Object sides.

(d) Select Show contours and click Parameters.

The Object face contours panel will open.
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Figure 1.14: Object Face Contours Panel
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(e) Keep the default selection of Temperature as the variable to be plotted.

(f) For Shading type, select Smooth.

(g) For Color limits, select Specified.

(h) Enter 20 next to Min and 50 next to Max.

The color range for the display will be based on the range of temperatures
you have specified. Since some of the heat sources have a very high calculated
temperature, modifying the range will produce a more meaningful display.

(i) Click Done to save the new settings and update the graphics display.

The graphics display will be updated to show the temperature contour plot, as
shown in Figure 1.15.

Figure 1.15: Temperature Contours on the Surface of Blocks in the Office

(j) In the Object face panel, turn off the Active option and click Update.
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4. Display particle traces of the air that is blown in through the inlet diffuser.

(a) Click on the Orient menu and select Positive Y.

(b) Click New in the Object face panel.

(c) In the Info tab, enter the name particle-trace in the Name field.

(d) In the Object drop-down list, select air-inlet.

(e) Click Accept.

(f) Keep the default Object sides.

(g) Select Show particle traces and click Parameters.

The Object face particles panel will open.

(h) Change the Start time and End time to 0 and 1200 respectively.

This specifies display of the path of air particles for the first 20 minutes they
are in the room.

(i) In the Display Options section, enter 15 in the Uniform text field.

This will set the number of particle traces that will be displayed.

(j) In the Animation section, enter 1200 in the End text field and 120 in the Steps
field.

(k) For Particle color, select Mean age of air from the Variable drop-down list.

(l) Click Done to close the panel and update the graphics display.

Figure 1.16 shows the path of air particles entering the office through the open-
ing at the top of the wall opposite the office window.

(m) In the Object face panel, turn off the Active option and click Done.

1-40 c© Fluent Inc. May 16, 2007



Office Ventilation

Figure 1.16: Particle Traces of Air Over 20 Minutes
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5. Display the predicted mean vote (PMV) of the office.

The predicted mean vote describes the comfort level of the people in the office with
regard to thermal sensation. The scale ranges from –3 (very cold) to 3 (very hot).

Post−→Plane cut

(a) Click on the Orient menu and select Isometric.

(b) Enter the name PMV in the Name field of the Plane cut panel.

(c) Select Point and normal for the plane specification.

(d) Specify the point (PX,PY,PZ) as (0,2.85,-2), and the normal (NX,NY,NZ)
as (0,0,1).

This defines a cross-section in the x-y plane, passing through the point (0,2.85,-
2).

(e) Select Show contours and click Parameters.

The Plane cut contours panel opens, select PMV in the Contours of drop-down
list.

(f) For Color levels, select Specified.

(g) Enter -3 next to Min and 3 next to Max.

Selecting a range of –3 to 3 will create a more readable scale for the display.

(h) At the top of the panel, click Parameters.

Airpak will open the Comfort level panel. You can keep the default settings in
this panel.

(i) In the Comfort level panel, click Compute to determine the minimum, maxi-
mum, average, and standard deviation of PMV.

Airpak will display these values in the Message window.

(j) Click Close to close the Comfort level panel.

(k) Click Done in the Plane cut contours panel to display contours of PMV, as
shown in Figure 1.17.

You can use the slider bar under Set plane in the Plane cut panel to move the
plane through the model.

(l) In the Plane cut panel, turn off the Active option and click Update.
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Figure 1.17: Predicted Mean Vote (PMV) Contours
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6. Display the predicted percentage dissatisfied (PPD) of the office.

Predicted percentage dissatisfied is another measure of the comfort level of the people
in the office. PPD is a rating of the number of people out of 100 who would be
dissatisfied with the comfort of their workspace.

(a) Click New in the Plane cut panel.

(b) In the Name field, enter the name PPD.

(c) Select Point and normal for the plane specification.

(d) Specify the point (PX, PY, PZ) as (0, 0.6, 0), and the normal (NX, NY, NZ)
as (0, 1, 0).

(e) Select Show contours and click Parameters.

The Plane cut contours panel will open.

(f) In the Plane cut contours panel, select PPD in the Contours of drop-down list.

(g) For Color levels, select Specified.

(h) Enter 0 next to Min and 100 next to Max.

Selecting a range of 0 to 100 will create a more readable scale for display.

(i) At the top of the panel, click Parameters.

Airpak will open the Comfort level panel. You can keep the default settings in
this panel.

(j) In the Comfort level panel, click Compute to determine the minimum, maxi-
mum, average, and standard deviation of PPD.

Airpak will display these values in the Message window.

(k) Click Close to close the Comfort level panel.

(l) Click Done to close the Plane cut contours panel and display the contours of
PPD, as shown in Figure 1.18.

To see a more vivid color contrast, you can limit the color range by specifying
different values for the Min and Max under Color limits in the Plane cut contours
panel.
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Figure 1.18: Predicted Percent Dissatisfied (PPD) in Working Plane
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Summary: In this tutorial, you created a simple model of an office and were able to
determine the flow patterns of the air in the room, the temperature distribution
in the room, the “freshness” of the air, and the expected comfort levels that the
ventilation system will provide the intended occupants.
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Tutorial 2. Laboratory Exhaust

Introduction: This tutorial demonstrates how to model a local laboratory ventilation
unit with a worker standing in front of the table.

In this tutorial you will learn how to:

• Create a new material

• Create a local ventilation unit

• Create a polygonal block

• Create a person object

• Specify meshing parameters for individual objects and copy these parameters
to other objects

• Create an on-screen animation of airflow through the lab

• Create an animated GIF file of airflow through the lab for use in external
multimedia programs

Prerequisites: This tutorial assumes that you are familiar with the menu structure in
Airpak and that you have solved or read Tutorial 1. Some steps in the setup and
solution procedure will not be shown explicitly.

Problem Description: The laboratory contains a worktable with a person standing in
front of it, as shown in Figure 2.1. A hood over the table is operated in a supply
and exhaust mode. An opening above the person supplies a down draft of air, and
an exhaust vent in the rear portion of the table pulls air out of the working area.
Additional room air supply and exhaust vents are located in the ceiling and upper
walls of the room.
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Figure 2.1: Problem Specification
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Step 1: Open and Define a New Job

1. Start Airpak, as described in Section 1.5 of the User’s Guide.

When Airpak starts, the New/existing panel will open automatically.

2. Click New in the New/existing panel to start a new Airpak project.

The New project panel will appear.

(a) Specify a name for your project in the Project text box.

You can enter the name lab.

(b) Click Create.

Airpak will create a default room with the dimensions 10 m × 3 m × 10 m, and
display the room in the graphics window.

You can rotate the room around a central point using the left mouse button, or you
can translate it to any point on the screen using the middle mouse button. You can
zoom into and out from the room using the right mouse button. To restore the room
to its default orientation, click on Orient menu and select Home position.

3. Modify the default surface material.

Problem setup−→ Basic parameters

(a) In the Basic parameters panel, select the Default values tab and click on the
drop-down list next to Default surface, select Create material.

Airpak will open the Materials panel.

(b) In the Info tab, enter the name surface-block in the Name field.

(c) In the Properties tab, enter 1 for the Emissivity.

(d) Click Done in the Materials panel.
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(e) Keep the default settings for all other parameters in the Basic parameters panel.

(f) Click Accept to save the new settings.
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Step 2: Build the Model
To build the model, you will first resize the room to its proper size. You will then create the
features of the room, including a person, a lab workstation, and the various components
of the airflow system. To save time, some objects will be created as copies of previous
objects.

1. Resize the default room.

Model−→Room

(a) In the Room edit panel, enter the following coordinates:

xS 0 xE 4.8

yS 0 yE 3.6

zS 0 zE 3.6

(b) Click Update to resize the room.

(c) Click on the Orient menu and select Isometric from the Orient drop-down list
to display an isometric view of the room.

(d) Click Done to close the Room edit panel.

2. Create the top of the lab table.

(a) Click in the object toolbar.

Airpak will create a new hollow prism block in the center of the room. You will
need to change both the size of the block and its location within the room.

(b) Double click block.1 and modify the default block in the Blocks panel.

(c) Enter the following coordinates for the top of the table:

xS 0 xE 1.0

yS 0.95 yE 1.0

zS 1.29 zE 2.31

(d) In the Info tab, enter the name tabletop in the Name field.

(e) Click Done to modify the block and close the Blocks edit panel.

3. Create the first leg for the table.

(a) Click in the object toolbar.

(b) Enter the following coordinates for the table leg:

xS 0 xE 0.08

yS 0 yE 0.95

zS 2.23 zE 2.31
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(c) In the Info tab, enter the name table-leg in the Name field.

(d) Click Done to update the block and close the Blocks panel.

4. Copy the first leg of the table (table-leg) to create the second leg (table-leg.1).

(a) Select table-leg in the Model manager window. list.

(b) Click Copy.

Airpak will open the Copy block table-leg panel.

(c) Turn on the Translate option and specify an X offset of 0.92.

(d) Click Apply.

Airpak will create a copy of the original leg that is offset 0.92 m in the x
direction.

5. Create the remaining two legs of the table.

(a) Create a group consisting of the two legs you have already created.

i. Select table-leg and table-leg.1 in the Model manager window using the
<Ctrl> key and the left mouse button .

ii. Right mouse click to display the context menu.

iii. Click Create group.

The Query panel will open.

iv. Enter table-leg as the Name for new group.

v. Click Done.

table-leg and table-leg.1 will be added to the Groups node in the Model
manager window.

(b) Make a copy of this group.

i. Select table-leg in the Model manager window.

ii. Right mouse click to display the context menu.

iii. Select Copy group to open the Copy group table-leg panel.

iv. Select the Translate option.

v. Set the X offset to 0, the Y offset to 0, and the Z offset to -0.94.

vi. Click Apply.

The display will be updated to show all four legs of the table.

vii. Click Done to close the Copy group table-leg panel.

6. Create the wall support for the hood.

(a) Click in the object toolbar.
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(b) Double click block.1 to display the Blocks edit panel.

(c) Enter the following coordinates:

xS 0 xE 0.5

yS 1.8 yE 2.2

zS 1.29 zE 2.31

(d) In the Info tab, enter the name hood-mount in the Name field.

(e) Click Done to modify the block and close the Blocks edit panel.

7. Create the hood for the lab table.

(a) Click in the object toolbar.

(b) Enter the following coordinates:

xS 0.5 xE 1.3

yS 2.0 yE 2.2

zS 1.29 zE 2.31

(c) In the Info tab, enter the name hood in the Name field.

(d) Click Done to modify the block and close the panel.

8. Create the air exhaust pipe.

(a) Click in the object toolbar.

(b) In the Geometry tab, select Cylinder from the Shape drop-down list.

(c) Enter the following information for the pipe:

xC 0.25 Radius 0.13

yC 2.2 Int Radius 0

zC 1.8 Height 1.4

(d) In the Info tab, enter the name cylinder in the Name field.

(e) Click Done to modify the block and close the panel.

9. Copy the air exhaust pipe (cylinder) to create the air intake pipe (cylinder.1).

(a) Select cylinder in the Model manager window.

(b) Select Copy object in the context menu.

Airpak will open the Copy block cylinder panel.

(c) Keep the Translate option turned on.

(d) Set the X offset to 0.65, the Y offset to 0, and the Z offset to 0.

(e) Click Apply to generate the second pipe and click Done to close the panel.

Airpak will create a second cylinder that is identical to the first and offset
0.65 m in the x direction.
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10. Create the air outflow duct.

(a) Click in the object toolbar.

(b) For the Geometry, select Polygon.

(c) Change the Plane to X-Y.

(d) Click the Add button to add a new vertex to the list of vertices.

(e) Click the Add button three more times to add three more vertices to the list.

There will be seven vertices in the list. If you add too many, select each extra
vertex and click Remove.

(f) Next to Height, enter 1.02 m.

(g) Select vert1 in the vertices list, and enter (0, 1, 1.29) for the coordinates of
(x1, y1, z1).

(h) Click Update to update the display of the vertex in the graphics window and
set the value of the z coordinate for the other vertices.

For the remaining vertices, you will enter only a pair of coordinates for each
vertex because you have already specified the z coordinate for all vertices.
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(i) For the remaining vertices, enter the following coordinates:

i. vert2: x2 = 0.15, y2 = 1.0

ii. vert3: x3 = 0.15, y3 = 1.1

iii. vert4: x4 = 0.20, y4 = 1.2

iv. vert5: x5 = 0.40, y5 = 1.4

v. vert6: x6 = 0.50, y6 = 1.8

vi. vert7: x7 = 0.00, y7 = 1.8

(j) In the Info tab, enter the name backstop in the Name field.

(k) Click Done to modify the block and close the Blocks panel.

11. Create the first side panel for the backstop.
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(a) Click in the object toolbar.

Airpak will create a 2D partition in the center of the room.

(b) For the Geometry, select Polygon.

(c) Select vert1 in the vertices list, and enter (0, 1, 1.29) for the coordinates of
(x1, y1, z1).

(d) Click Update to update the display of the vertex in the graphics window and
set the value of the z coordinate for the other vertices.

(e) For the remaining vertices, enter the following coordinates:

i. vert2: x2 = 0.3, y2 = 1.0

ii. vert3: x3 = 0.5, y3 = 1.8

iii. vert4: x4 = 0.0, y4 = 1.8

(f) In the Info tab, enter the name backstop-end in the Name field.

(g) Click Done to modify the partition and close the Partitions panel.

12. Copy the side of the backstop (backstop-end) to create the other side (backstop-
end.1).

(a) Select backstop-end in the Model manager window.

(b) Click Copy object.

Airpak will open the Copy partition backstop-end panel.

(c) Set the X offset to 0, the Y offset to 0, and the Z offset to 1.02.

(d) Click Apply to generate the second side and close the panel.

Airpak will create a second side panel that is identical to the first and offset
1.02 m in the z direction.

13. Create the first exhaust opening.

This opening will extract air from the table.

(a) Click in the object toolbar.

Airpak will create a 2D opening in the center of the room. You will need to
change the orientation and specify air flow information.

(b) Change the Plane to Y-Z.

(c) Enter the following coordinates for the opening:

xS 0.15 xE —–
yS 1.0 yE 1.1

zS 1.29 zE 2.31
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(d) Select X Velocity and enter a value of -2 m/s.

You can keep opening.1 as the object name.

(e) Click Done to modify the opening and close the panel.

14. Create the second exhaust opening.

(a) Click in the object toolbar.

(b) Change the Plane to Y-Z.

(c) Enter the following coordinates for the opening:

xS 0 xE —–
yS 2.5 yE 3.5

zS 1.29 zE 2.31

(d) Select Static press (static pressure) and keep the default value of ambient

(which is defined to be 0 N/m2 in the Basic parameters panel).

You can keep opening.2 as the object name.

(e) Click Done to modify the opening and close the panel.

15. Create the air inflow opening.

This opening will supply air from outside the lab.

(a) Click in the object toolbar.

(b) Change the Plane to X-Z.

(c) Enter the following coordinates for the opening:

xS 0.5 xE 1.3

yS 2.0 yE —–
zS 1.29 zE 2.31

(d) Select Y Velocity and enter a value of -0.325 m/s.

You can keep opening.3 as the object name.

(e) Click Done to modify the opening and close the panel.

16. Create the first inlet air diffuser.

(a) Click in the object toolbar.

(b) Change the Plane to X-Z.

(c) Enter the following coordinates for the opening:

xS 1.9 xE 2.2

yS 3.6 yE —–
zS 1.4 zE 2.2
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(d) Select Y Velocity and enter a value of -0.143 m/s.

You can keep opening.4 as the object name.

(e) Click Done to modify the opening and close the Openings panel.

17. Copy the last opening you created (opening.4) to create two more openings on
the ceiling of the lab.

(a) Select opening.4 in the Model manager window.

(b) Click Copy object.

Airpak will open the Copy opening opening.4 panel.

(c) Enter 2 as the Number of copies.

(d) Keep the Translate option turned on.

(e) Set the X offset to 0.35, the Y offset to 0, and the Z offset to 0.

(f) Click Apply to generate the new openings and close the panel.

Airpak will create two additional openings that are identical to the first and
offset by 0.35 m in the x direction.

18. Create the person working at the lab table.

(a) Click in the object toolbar.

Airpak will generate the outline of a person standing at the center of the room.
You will now change the shape and position of the person.

(b) In the Person edit panel, Properties tab, next to Facing direction, select X and
then select Backward.

(c) Set the location and the dimensions of the person.

i. Enter (1.25, 0, 1.8) as the (X, Y, Z) coordinates for the Location of the
person.

ii. Enter the following information for the person’s overall dimensions:

Total height 1.785

Body width 0.4

Body depth 0.25

(d) Select the Radiation option.

(e) Click Done to update the person and close the panel.
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The completed model will look like Figure 2.2.

Figure 2.2: Completed Model for the Lab Exhaust Simulation

19. Check the model to be sure that there are no problems (e.g., objects that are too
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close together to allow for proper mesh generation).

Model−→Check model

Airpak should report in the Message window that 0 problems were found and all
tolerances are acceptable.

20. Check the definition of the modeling objects to ensure that you specified them
properly.

View−→Summary (HTML)

Airpak will list the specifications for all modeling objects in a web browser which
can be launched from selecting the View menu and clicking Summary (HTML). You
can check them here and if you notice any incorrect specifications, you can change
them in the object’s edit panel.

Note: The problem described here is symmetric, and you could have reduced the
size of the computational domain by creating a hollow block and a symmetry
plane to effectively block out half of the domain. However, anticipating that
additional objects may be introduced into the model or that swirling flows may
be considered at a later time, the current analysis will be carried out without
taking advantage of the symmetry present.

Step 3: Generate a Mesh
You will generate the mesh in two steps. First you will create a coarse mesh and examine
it to determine where further mesh refinement is required. Then you will refine the mesh
based on your observations of the coarse mesh.

Model−→Generate Mesh

1. Generate a coarse (minimum-count) mesh.

(a) Click the Coarse button at the bottom of the Mesh control panel.

Airpak will update the panel with the default meshing parameters for a coarse
(minimum-count) mesh.

(b) Deselect Max X size, Max Y size, and Max Z size.

(c) Click the Generate mesh button to generate the coarse mesh.

2. Examine the coarse mesh on a cross-section of the model.

(a) Select Display at the top of the Mesh control panel.

The panel will be updated to show the mesh display tools.
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(b) Turn on the Cut plane option.

(c) Select Point and normal from the Set position drop-down list.

(d) Keep the default settings of (0, 0, 1.8) for (PX, PY, PZ), and (0, 0, 1) for
(NX, NY, NZ).

These settings will result in a mesh display on an x-y plane passing through
the point (0, 0, 1.8).

(e) Turn on the Display mesh option.

(f) Click the two square boxes to advance the plane cut through the model.

Figure 2.3: Coarse Mesh on the x-y Plane
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3. Generate a finer mesh.

(a) Select Generate at the top of the Mesh control panel.

The panel will be updated to show the mesh generation tools again.

(b) Click the Normal button at the bottom of the Mesh control panel.

Airpak will update the panel with the default meshing parameters for a “nor-
mal” (i.e., finer than coarse) mesh.

(c) Turn on the Max X size, Max Y size, and Max Z size options, and set each to
0.5.

(d) Select Per-object params and click Edit.

Airpak will open the Per-object mesh parameters panel.

(e) Set object-specific meshing parameters for opening.1.

i. In the Per-object mesh parameters panel, scroll down and turn on opening.1.

ii. Click Use per-object parameters.

iii. Select Y count and Z count.

iv. Under Requested, enter 5 for Y count and Z count.

v. Click Done in the Per-object mesh parameters panel to save the settings.

(f) Set object-specific meshing parameters for all of the openings.

i. In the Per-object mesh parameters panel, scroll down and select opening.1.

ii. In the opening.1 panel, click Copy to.

iii. In the Per-object mesh parameters panel, click on each of the openings.
Each one will be turned on and displayed in red as you click on it, and
the meshing parameters will be copied from opening.1

iv. In the opening.1 panel, click Copy to again to complete the operation.

v. Click Done in the opening.1 panel to save the settings and close the
panel.
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vi. Click the Generate mesh button in the Mesh control panel to generate the
finer mesh.

(g) Examine the new mesh.

The graphics display will be updated automatically to show the new mesh (Fig-
ure 2.4). You can use the two square boxes in the Display section of the Mesh
control panel to advance the plane cut and view the mesh throughout the model.

Figure 2.4: Fine Mesh on the x-y Plane

(h) Turn off the mesh display.

i. Select Display at the top of the Mesh control panel.

ii. Deselect the Display mesh option.

iii. Click Close to close the Mesh control panel.
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Step 4: Check the Flow Regime
Before starting the solver, you will first review estimates of the Reynolds and Peclet
numbers to check that the proper flow regime is being modeled.

1. Check the values of the Reynolds and Peclet numbers.

Solve−→Settings−→Basic

(a) Click the Reset button.

(b) Check the values printed to the Message window.

The Reynolds and Peclet numbers are approximately 14000 and 10000, re-
spectively, so the flow is turbulent. Since turbulence is already enabled in the
problem setup, no changes are required. The Message window will also re-
port that the initial air velocity has been reset to −10−4 times gravity. This
modification improves the convergence of natural convection calculations.

(c) Click Accept to save the new solver settings.

Step 5: Save the Model to a Job File
Airpak will save the model for you automatically before it starts the calculation, but it is
a good idea to save the model (including the mesh) yourself as well. If you exit Airpak
before you start the calculation, you will be able to open the job you saved and continue
your analysis in a future Airpak session. (If you start the calculation in the current Airpak
session, Airpak will simply overwrite your job file when it saves the model.)

File−→Save Project

Step 6: Calculate a Solution

1. Increase the Number of iterations to 1000.

Solve−→Settings−→Basic

2. Modify the parameters for the solver.

Solve−→Settings−→Advanced

(a) In the Advanced solver setup panel, enter the following values for Under-relaxation:

• Pressure: 0.3

• Momentum: 0.1
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• Retain the defaults for Temperature, Viscosity, and Body forces.

(b) Click Accept to store the settings and close the Advanced solver setup panel.

3. Start the calculation.

Solve−→Run Solution

(a) Keep the default settings in the Solve panel.

(b) Click Accept to start the solver.

The solution will converge after about 400 iterations. In the window where the
residual values are printed, the calculation will continue after the residual plot
stops, as the equations for radiation and mean age of air are solved. When
the solution is completed, you can close the Monitor window by clicking Done.

If you do not want to wait for the calculation to finish, you can save time by
reading in the results provided in the tutorials directory and then following
the instructions (in the next step of this tutorial) for examining the results.
See the preface (Using This Manual) for details.

Step 7: Examine the Results
The objective of this exercise is to consider the velocity of the air moving within the lab,
and also to trace the direction of individual particles from the air inlet streams. You will
accomplish this by examining the solution using Airpak’s graphical postprocessing tools.

1. Display velocity vectors on a plane cut through the lab.

Post−→Plane cut

(a) In the Name field, enter the name velocity-vectors.

(b) Select Point and normal for the plane specification.

(c) Specify the point (PX, PY, PZ) as (0, 0, 2.34), and the normal (NX, NY,
NZ) as (0, 0, 1).

This defines a cross-section in the x-y plane, passing through the point (0, 0,
2.34).

(d) Select Show vectors and click Parameters.

Airpak will open the Plane cut vectors panel.
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(e) Under Color levels, select Calculated and This object.

(f) Click Done to update the graphics window and close the panel.

(g) Click on the Orient menu and select Orient Negative Z from the Orient drop-
down list.

This will orient the model as shown in Figure 2.5. You can see the flow
distribution of low-velocity ventilation air throughout the lab on this plane.

(h) Click Create in the Plane cut panel.

(i) In the Plane cut panel, turn off the Active option.

This will temporarily remove the velocity vector display from the graphics win-
dow, so that you can more easily view the next postprocessing object.
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Figure 2.5: Velocity Vectors in an x-y Cross-Section
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2. Display the mean age of the air in the office.

(a) Select the Post menu and click Plane cut.

(b) In the Name field, enter the name mean-age-air.

(c) Select Point and normal for the plane specification.

(d) Specify the point (PX, PY, PZ) as (0, 0, 1.8), and the normal (NX, NY, NZ)
as (0, 0, 1).

This defines a cross-section in the x-y plane, passing through the point (0, 0,
1.8).

(e) Select Show contours and click Parameters.

The Plane cut contours panel will open.

(f) Select Mean age of air in the Contours of drop-down list.

(g) Click Done to save the new settings, close the panel, and update the graphics
display.

(h) Click on the Orient menu and select Isometric from the Orient drop-down list.

The graphics display will be updated to show the mean age of air contour plot,
shown in Figure 2.6.

Figure 2.6: Mean Age of Air Contours in a Plane

(i) In the Plane cut panel, turn off the Active option.
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3. Display an animated particle trace of the air that is blown in from the top of the
hood.

Post−→Object face

(a) To provide a more realistic view, change the graphics window so that the
hidden lines and the outline of the room are not displayed.

i. Click on the View menu and select Shading and Hidden line from the View
drop-down list.

ii. Click on Visible in the View menu and deselect Room in the Visible drop-
down list.

(b) In the Object face panel, enter the name particle-trace in the Name field.

(c) In the Object drop-down list, select opening.3 and click Accept.

(d) Under Display options, select Show particle traces and click Parameters.

The Object face particles panel will open.

(e) Change the Start time and End time to 0 and 30, respectively.

This specifies display of the path of air particles for the first 30 seconds they
are in the room.

(f) Under Display Options, enter 100 in the Uniform text field.

This will set the number of particle traces that will be displayed.

(g) For Particle color, select Mean age of air from the Variable drop-down list.

(h) In the Animation section, enter 30 in the End text field.

(i) Click the Animation button.

Airpak will display the path of the air particles entering the lab through the top
of the hood, as shown in Figure 2.7
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Figure 2.7: Particle Traces of Air Over 30 Seconds
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(j) Create and view a 10-frame animation of the particle traces.

i. In the Object face particles panel, change Steps to 10.

ii. Set the Delay to 24.

iii. Turn on the Loop mode option.

iv. Click Animate to start the animation.

The graphics window will show a repeating 10-frame animation of the air
flow from the hood opening. To exit the loop mode, click Interrupt, turn
off the Loop mode option, and click Animate in the Object face particles
panel.

4. Export the animation to an animated GIF file.

(a) In the Object face particles panel, select Write to file.

(b) Click Write.

(c) In the Save animation dialog box, keep the default filename (animation.gif).

(d) Click Save.

Summary: In this tutorial, you created a simple model of a laboratory and determined
the flow patterns in the room and the mean age of the air. You created and viewed
an animation of the airflow through the lab and created an animated GIF file of
the airflow for use in an external multimedia program.
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Tutorial 3. Copy Machine Emitting Volatile Gases

Introduction: This tutorial demonstrates how to model fluid exhaust streams emitted
from an office copy machine.

In this tutorial you will learn how to:

• Create a polygonal block

• Create a person object

• Model the dispersion of gaseous species throughout a room

• Change the legend precision for postprocessing results in the graphics window

Prerequisites: This tutorial assumes that you are familiar with the menu structure in
Airpak and that you have solved or read Tutorial 1. Some steps in the setup and
solution procedure will not be shown explicitly.

Problem Description: The room, shown in Figure 3.1, contains a copier with rear
sources that emit waste gases. Other objects in the room include a person, a trash
can, a file cabinet, closets, and exhaust vents. The goal of the simulation is to
report on the concentration of total volatile organic compounds (VOCs). VOCs,
which normally are gaseous hydrocarbons, are criteria pollutants that can be found
in all non-industrial environments. These chemicals are produced by a wide range
of sources, and are of particular interest in addressing indoor air quality (IAQ)
concerns.

c© Fluent Inc. May 16, 2007 3-1



Copy Machine Emitting Volatile Gases

Figure 3.1: Problem Specification
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Step 1: Open and Define a New Job

1. Start Airpak, as described in Section 1.5 of the User’s Guide.

When Airpak starts, the New/existing panel will open automatically.

2. Click New in the New/existing panel to start a new Airpak project.

The New project panel will appear.

(a) Specify a name for your project in the Project text box.

You can enter the name /copier.

(b) Click Create.

Airpak will create a default room with the dimensions 10 m × 3 m × 10 m, and
display the room in the graphics window.

You can rotate the room around a central point using the left mouse button, or you
can translate it to any point on the screen using the middle mouse button. You can
zoom into and out from the room using the right mouse button. To restore the room
to its default orientation, click on Orient menu and select Home position from the
Orient drop-down list.

3. Modify the overall problem definition to include the effects of species mixing and
to use a different default surface material.

Problem setup−→ Basic parameters

(a) In the Basic parameters panel, select On next to Species and click Edit.

Airpak will open the Species definition panel.
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Figure 3.2: The Species Definition Panel
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i. Click the arrow button next to h2o to open the materials drop-down list.

ii. Under Gases, select Benzene.

iii. Set the Initial concentration of Benzene to 0.

iv. Click Accept.

(b) In the Default values tab (within the Basic parameters panel), select Plastics-
infrared Opaque from the drop-down list next to Default surface.

(c) Keep the default settings for all other parameters in the Basic parameters panel.

(d) Click Accept to save the new settings.
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Step 2: Build the Model
To build the model, you will first resize the room to its proper size. Then you will create
the features of the room, including a person, a copy machine, and the various vents and
openings. To save time, some objects will be created as copies of previous objects.

1. Resize the default room.

Model−→Room

(a) In the Room edit panel, enter the following coordinates:

xS 0 xE 4.8

yS 0 yE 2.3

zS 0 zE 4.0

(b) Click Done to resize the room.

(c) Click on the Orient menu and select Isometric from the Orient drop-down list
to display an isometric view of the room.

2. Create the main body of the copier.

(a) Click in the object toolbar.

Airpak will create a new hollow prism block in the center of the room. You will
need to change both the size of the block and its location within the room.

(b) Double click block.1 to modify the default block.

(c) Enter the following coordinates:

xS 1.91 xE 2.8

yS 0 yE 0.93

zS 0.15 zE 0.81

(d) Set the Total power under Thermal Specification to be 200 W.

(e) In the Info tab, enter the name copier-body in the Name field.

(f) Click Done to modify the block.

3. Create the side panel of the copier.

(a) Click in the object toolbar.

(b) Enter the following coordinates:

xS 2.8 xE 2.98

yS 0 yE 0.62

zS 0.15 zE 0.81

(c) In the Info tab, enter the name copier-side in the Name field.
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(d) Click Done to modify the block.

4. Create the top of the copier.

(a) Click in the object toolbar.

(b) Enter the following coordinates:

xS 2.02 xE 2.68

yS 0.93 yE 1.05

zS 0.216 zE 0.74

(c) In the Info tab, enter the name copier-top in the Name field.

(d) Click Done to update the block.

5. Create the support structure for the output tray.

(a) Click in the object toolbar.

(b) For the Geometry, select Polygon.

(c) Change the Plane to X-Z.

(d) Click the Add button to add a new vertex to the list of vertices.

(e) Click the Add button four more times to add four more vertices to the list

There will be eight vertices in the list. If you add too many vertices, select
each extra vertex and click the Remove button to remove it.
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Figure 3.3: The Blocks Panel

(f) Next to Height, enter 0.93 m.

(g) Select vert1 in the vertices list, and enter (1.91, 0, 0.182) for the coordi-
nates of (x1, y1, z1).

(h) Click Update to update the display of the vertex in the graphics window and
set the value of the y coordinate for the other vertices.

For the remaining vertices, you will enter only a pair of coordinates for each
vertex because you have already specified the y coordinate for all vertices.

(i) For the remaining vertices, enter the following coordinates:
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i. vert2: x2 = 1.68, z2 = 0.182

ii. vert3: x3 = 1.68, z3 = 0.29

iii. vert4: x4 = 1.81, z4 = 0.29

iv. vert5: x5 = 1.81, z5 = 0.67

v. vert6: x6 = 1.68, z6 = 0.67

vi. vert7: x7 = 1.68, z7 = 0.78

vii. vert8: x8 = 1.91, z8 = 0.78

(j) In the Info tab, enter the name copier-output in the Name field.

(k) Click Done to modify the block.

6. Create the copier tray.

(a) Click in the object toolbar.

(b) For the Geometry, select Polygon.

(c) Change the Plane to X-Y.

(d) Click the Add button to add a new vertex to the list of vertices.

(e) Next to Height, enter 0.38 m.

(f) Select vert1 in the vertices list, and enter (1.81, 0.61, 0.29) for the coordi-
nates of (x1, y1, z1).

(g) Click Update to update the display of the vertex in the graphics window and
set the value of the z coordinate for the other vertices.

(h) For the remaining vertices, enter the following coordinates:

i. vert2: x2 = 1.56, y2 = 0.74

ii. vert3: x3 = 1.56, y3 = 0.28

iii. vert4: x4 = 1.81, y4 = 0.15

(i) In the Info tab, enter the name copier-tray in the Name field.

(j) Click Done to modify the block.

7. Create the file cabinet.

(a) Click in the object toolbar.

(b) Enter the following coordinates:

xS 4 xE 4.8

yS 0 yE 0.9

zS 0 zE 2.7

(c) In the Info tab, enter the name cabinet in the Name field.
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(d) Click Done to modify the block.

8. Create the first closet.

(a) Click in the object toolbar.

(b) Enter the following coordinates:

xS 0 xE 0.6

yS 0 yE 2.0

zS 0 zE 0.6

(c) In the Info tab, enter the name closet1 in the Name field.

(d) Click Done to modify the block.

9. Create the second closet.

(a) Click in the object toolbar.

(b) Enter the following coordinates:

xS 0 xE 0.6

yS 0 yE 2.0

zS 0.6 zE 1.2

(c) In the Info tab, enter the name closet2 in the Name field.

(d) Click Done to modify the block.

10. Create the trash can.

(a) Click in the object toolbar.

(b) For the Geometry, select Cylinder.

(c) Change the Plane to X-Z.

(d) Enter the following information for the trash can:

xC 3.6 Radius 0.25

yC 0 Int Radius 0

zC 0.5 Height 0.6

(e) In the Info tab, enter the name trash in the Name field.

(f) Click Done to modify the block and close the Blocks panel.
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11. Create the first of a set of three vents for the room.

(a) Click in the object toolbar.

Airpak will create a vent object in the center of the room. You will need to
change the orientation and parameters of the vent.

(b) In the Geometry tab, change the Plane to X-Z.

(c) Enter the following coordinates:

xS 0.4 xE 0.7

yS 2.3 yE —–
zS 0.4 zE 0.9

(d) For the Velocity loss coefficient, select Device.

(e) Select Species.

The default values for the mass fractions of the species are correct, so you do
not need to make any changes to the species concentrations.

(f) Click Done to update the vent and close the Vents panel.

12. Copy the first vent (vent.1) to create two more vents on the ceiling of the room.

(a) In the vents edit panel, select vent.1.

(b) Click Copy.

Airpak will open the Copy vent vent.1 panel.

(c) Enter 2 as the Number of copies.

(d) Select Translate and enter 1.35 next to Z offset.

(e) Retain the default X offset and Y offset of 0.

(f) Click Apply to generate the new vents and close the panel.

Two additional vents now appear in the graphics display that are identical to
the first and offset by 1.35 m in the z direction.

13. Create the first benzene emission source.

(a) Click icon in the object toolbar.

Airpak will create a 2D opening in the center of the room. You will need to
change the size and orientation of the opening and specify the temperature and
air flow information.

panel.

(b) Enter the following coordinates for the opening in the Geometry tab:

xS 2.18 xE 2.23

yS 0.69 yE 0.74

zS 0.15 zE —–
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Figure 3.4: The Species Concentrations Panel

(c) In the Properties tab, select Temperature.

(d) Set the Temperature and change the units for it from Celsius to Fahrenheit.

i. Enter a value of 100 in the Temperature text-entry field.

ii. Select F from the drop-down list.

(e) Select Z Velocity and enter a value of -0.833 m/s.

(f) Select Species and click Edit.

Airpak will open the Species concentrations panel.

i. Under Concentration, enter a value of 1 for Benzene.

ii. Click Done to store the value and close the panel.

(g) In the Info tab, enter the name benz1 in the Name field of the Openings panel.

(h) Click Update to update the opening.

14. Create the second benzene emission source.

(a) Click in the object toolbar.

(b) Enter the following coordinates for the opening:

xS 2.4 xE 2.465

yS 0.573 yE 0.642

zS 0.15 zE —–

(c) Select Temperature and enter a value of 100◦F.

! Remember to change the unit for Temperature from C to F.

(d) Select Z Velocity and enter a value of -0.833 m/s.

(e) Select Species and click Edit.

Airpak will open the Species concentrations panel.

i. Under Concentration, enter a value of 1 for Benzene.

ii. Click Done.
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(f) In the Info tab, enter the name benz2 in the Name field of the Openings panel.

(g) Click Done to update the opening.

15. Create the third benzene emission source.

(a) Click in the object toolbar.

(b) Enter the following coordinates for the opening:

xS 2.346 xE 2.393

yS 0.455 yE 0.503

zS 0.15 zE —–

(c) Select Temperature and enter a value of 100◦F.

! Remember to change the unit for Temperature from C to F.

(d) Select Z Velocity and enter a value of -0.833 m/s.

(e) Select Species and click Edit.

Airpak will open the Species concentrations panel.

i. Under Concentration, enter a value of 1 for Benzene.

ii. Click Done.

(f) In the Info tab, enter the name benz3 in the Name field of the Openings panel.

(g) Click Done to update the opening.

16. Create the doorway into the room.

(a) Click in the object toolbar.

(b) Change the Plane to Y-Z.

(c) Enter the following coordinates:

xS 0 xE —–
yS 0 yE 2.1

zS 1.78 zE 2.78

(d) In the Properties tab, select Static press (static pressure) and keep the default
value (which is defined to be 0 N/m2 in the Default values tab).

(e) Select Temperature and keep the default value (which is defined to be 20◦C in
the Default values tab).

(f) In the Info tab, enter the name doorway in the Name field.

(g) Click Done to update the opening.

17. Create the air-outlet opening in the ceiling.

Essentially, you are creating an exhaust fan, but for this simulation, it will be treated
as an Opening object.
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Figure 3.5: The Persons Panel

(a) Click in the object toolbar.

(b) Change the Plane to X-Z.

(c) Enter the following coordinates:

xS 4.0 xE 4.5

yS 2.3 yE —–
zS 1.2 zE 2.7

(d) Select Temperature and keep the default value.

(e) Select Y Velocity and enter a value of 5 m/s.

(f) In the Info tab, enter the name air-outlet in the Name field.

(g) Click Done to update the opening and close the Openings panel.

18. Create the person working at the copier.

(a) Click in the object toolbar.

Airpak will generate the outline of a person standing at the center of the room.
You will now change the position of the person.

(b) Next to Facing direction, keep the default selection of Z and select Backward.
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(c) Enter (2.42, 0, 1.07) as the (X, Y, Z) coordinates for the Location of the
person.

(d) Click Done to update the person and close the panel.

19. Create the door to the room.

(a) Click in the object toolbar.

(b) Change the Geometry to Inclined.

(c) Select the Start/angle option.

(d) Next to Axis of rotation, select Y.

(e) Enter the following information for the door:

xS 0 xL —–
yS 0 yL 2.1

zS 2.78 zL 1

Angle 75

(f) In the Info tab, enter the name door in the Name text field.

Figure 3.6: The Partitions Panel
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(g) Click Done to update the door and close the Partitions panel.

The completed model will look like Figure 3.7.

Figure 3.7: Completed Model for the Copier Emissions Simulation

20. Check the model to be sure that there are no problems (e.g., objects that are too
close together to allow for proper mesh generation).

Model−→Check model

Airpak should report in the Message window that 0 problems were found and all
tolerances are acceptable.

21. Check the definition of the modeling objects to ensure that you specified them
properly.

View−→Summary (HTML)

Airpak will list the specifications for all modeling objects in a web browser which
can be launched from selecting the View menu and clicking Summary (HTML). You
can check them here and if you notice any incorrect specifications, you can change
them in the object edit panel.
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Step 3: Add Radiation to the Model
In this step, you will include the effects of radiation in your model.

1. Enable radiation modeling.

Model−→Radiation

(a) Under the Enabled list, click All to select all of the objects in the room.

(b) Click Compute.

Airpak will compute the form factors for the selected objects. See the User’s
Guide for details about modeling radiation.

Note: It will take several minutes for Airpak to complete the radiation calcu-
lations. The Message window will report when it is Done computing form
factors.

(c) Click Close in the Form factors panel.

Step 4: Generate a Mesh
You will generate the mesh in two steps. First you will create a coarse mesh and examine
it to determine where further mesh refinement is required. Then you will refine the mesh
based on your observations of the coarse mesh.

Model−→Generate mesh
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1. Generate a coarse (minimum-count) mesh.

(a) Click the Coarse button at the bottom of the Mesh control panel.

Airpak will update the panel with the default meshing parameters for a coarse
(minimum-count) mesh.

(b) Deselect Max X size, Max Y size, and Max Z size.

(c) Click the Generate mesh button to generate the coarse mesh.

2. Examine the coarse mesh on a cross-section of the model.

(a) Select Display at the top of the Mesh control panel.

The panel will be updated to show the mesh display tools.

(b) Turn on the Cut plane option.

(c) Select Point and normal in the Set position drop-down list.

(d) Keep the default settings of (0, 0, 2.0) for (PX, PY, PZ), and (0, 0, 1) for
(NX, NY, NZ).

These settings will result in a mesh display on an x-y plane passing through
the point (0, 0, 2).

(e) Turn on the Display mesh option.

(f) Click on the two square boxes to advance the plane cut through the model.

An example of the view of the mesh on an x-y plane is shown in Figure 3.8.
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Figure 3.8: Coarse Mesh on the x-y Plane

3. Generate a finer mesh.

(a) Select Generate at the top of the Mesh control panel.

The panel will be updated to show the mesh generation tools again.

(b) Click the Normal button at the bottom of the Mesh control panel.

Airpak will update the panel with the default meshing parameters for a “nor-
mal” (i.e., finer than coarse) mesh.

(c) Select the Max X size, Max Y size, and Max Z size options, and set each to 0.2.

(d) Set both the Min elems in gap and the Min elems on edge to 4.

The Min elements in fluid gap and Min elements on solid edge are changed from
the default values to 4 to provide a finer mesh resolution for the components
of the person and also for the opening regions at the rear of the copier. For
this case, these changes will improve the quality of the mesh and lead to better
convergence performance of the solver.

(e) Set Max size ratio to 1.5.

This change will reduce the rate at which the cell size grows and lead to a better
quality mesh that will converge more easily for this case.

(f) Set object-specific meshing parameters for the three vents.
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i. Select Per-object params and click Edit.

Airpak will open the Per-object mesh parameters panel.

ii. In the Per-object mesh parameters panel, scroll down and turn on vent.1
under Vents.

iii. Click Edit next to vent.1.

Airpak will open the vent.1 panel, where you can set object-specific meshing
parameters for the vent.

iv. Select X count and Z count.

v. Under Requested, enter 4 for X count and Z count.

vi. In the vent.1 panel, click Copy to.

vii. In the Per-object mesh parameters panel, click on each of the vents while
holding down the <Ctrl> key.

Each vent will be turned on as you click on it, and the meshing parameters
will be copied from vent.1.

viii. In the vent.1 panel, click Copy to again to complete the operation.

(g) Set object-specific meshing parameters for the three benzene sources.

i. In the Per-object mesh parameters panel, scroll down and turn on benz1.

ii. Click Use per-object parameters.

iii. Select X count and Y count.

iv. Under Requested, enter 5 for X count and Y count.

v. In the benz1 panel, click Copy to.

vi. In the Per-object mesh parameters panel, click on benz2 and benz3 while
holding down the <Ctrl> key.

vii. In the benz1 panel, click Copy to again to complete the operation.

viii. Click Done in the benz1 panel to save the settings and close the panel.

ix. In the Per-object mesh parameters panel, click Done to save all the object-
specific meshing parameters and close the panel.

(h) Click the Generate mesh button in the Mesh control panel to generate the finer
mesh.

4. Examine the new mesh.

The graphics display will be updated automatically to show the new mesh (Fig-
ure 3.9). You can use the two boxes in the Display section of the Mesh control panel
to advance the plane cut and view the mesh throughout the model.

5. Turn off the mesh display.
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Figure 3.9: Fine Mesh on the x-y Plane

(a) Select Display at the top of the Mesh control panel.

(b) Deselect the Display mesh option.

(c) Click Close to close the Mesh control panel.
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Step 5: Check the Flow Regime
Before starting the solver, you will first review estimates of the Reynolds and Peclet
numbers to check that the proper flow regime is being modeled.

1. Check the values of the Reynolds and Peclet numbers.

Solve−→Settings−→Basic parameters

(a) Click the Reset button.

(b) Check the values printed to the Message window.

The Reynolds and Peclet numbers are approximately 171000 and 127000, re-
spectively, so the flow is turbulent. Since turbulence is already enabled in the
Basic parameter panel, no changes are required. The Message window will also
report that the initial air velocity has been reset to −10−4 times gravity. This
modification improves the convergence of natural convection calculations.

(c) Click Accept to save the solver settings.

Step 6: Save the Model to a Job File
Airpak will save the model for you automatically before it starts the calculation, but it is
a good idea to save the model (including the mesh) yourself as well. If you exit Airpak
before you start the calculation, you will be able to open the job you saved and continue
your analysis in a future Airpak session. (If you start the calculation in the current Airpak
session, Airpak will simply overwrite your job file when it saves the model.)

File−→Save Project

3-22 c© Fluent Inc. May 16, 2007



Copy Machine Emitting Volatile Gases

Step 7: Calculate a Solution

1. Increase the number of iterations.

Solve−→Settings−→Basic

(a) Increase the Number of iterations to 500.

(b) Click Accept.

2. Start the calculation.

Solve−→Run Solution

(a) Keep the default settings in the Solve panel.

(b) Click Start Solution to start the solver.

The solution will converge after about 300 iterations. In the window where the
residual values are printed, the calculation will continue after the residual plot
stops, as the equations for radiation and mean age of air are solved. When
the solution is completed, you can close the Monitor window by clicking Done.

If you do not want to wait for the calculation to finish, you can save time by
reading in the results provided in the tutorials directory and then following
the instructions (in the next step of this tutorial) for examining the results.
See the preface (Using This Manual) for details.
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Step 8: Examine the Results
The objective of this exercise is to consider the velocity of the air moving within the
lab, and also to trace the direction of individual particles from the various fluid streams.
You will accomplish this by examining the solution using Airpak’s graphical postprocessing
tools.

1. Display velocity vectors on a plane cut through the lab.

Post−→Plane cut

(a) In the Name field, enter the name velocity-vectors.

(b) Select Point and normal for the plane specification.

(c) Specify the point (PX, PY, PZ) as (0, 0, 0.1), and the normal (NX, NY, NZ)
as (0, 0, 1).

This defines a cross-section in the x-y plane, passing through the point (0, 0,
0.1).

(d) Select Show vectors and click Parameters.

Airpak will open the Plane cut vectors panel.

Figure 3.10: The Plane Cut Vectors Panel
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(e) Under Color levels, select Calculated and This object.

(f) Click Done to update the graphics window and close the panel.

(g) Click on Orient menu and select Positive Z from the Orient drop-down list.

This will orient the model as shown in Figure 3.11. You can see the flow
distribution of low-velocity ventilation air throughout the room on this plane.

Figure 3.11: Velocity Vectors in an x-y Cross-Section
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(h) In the Plane cut panel, turn off the Active option and click Done.

This will temporarily remove the velocity vector display from the graphics win-
dow, so that you can more easily view the next postprocessing object.

2. Display contours of temperature on the block surfaces in the room.

Post−→Object face

(a) Click on Orient menu and select Isometric.

(b) In the Name field, enter the name temp-contours.

(c) In the Object drop-down list, select all the block objects.

Hint: To select all the block objects, hold down the <Ctrl> or <Shift> key
while selecting objects.

(d) Select Show contours.

(e) In the Object face contours panel, select Specified in the Color levels section.
Enter 20 for Min and 37 for Max.

(f) Click Create to generate temperature contours on the blocks.

(g) Modify the precision of the legend in the graphics window.

Edit−→Preferences

Airpak will open the Preferences panel.

i. Click Display in the Options node to display the configuration options.

ii. Under Color legend data format, select float.

This instructs Airpak to display real values with an integral and fractional
part.

iii. Set the Numerical display precision to 3.

This instructs Airpak to display three decimal places for each value in the
legend.

iv. Click This project to apply the settings to this project only and close the
panel.

The temperature contour plot will be updated to show the new legend precision,
as shown in Figure 3.13.
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Figure 3.12: The Preferences Panel
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Figure 3.13: Temperature Contours on the Surfaces of Blocks in the Room

(h) In the Object face panel, turn off the Active option and click Update.

3. Display particle traces of the air and benzene throughout the room.

(a) Click New in the Object face panel.

(b) In the Name field, enter the name particle-trace.

(c) In the Object drop-down list, select all opening objects.

Hint: To select all openings, hold down the <Ctrl> or <Shift> key while
selecting objects.

(d) Select Show particle traces and click Parameters.

The Object face particles panel will open.

(e) Change the Start time and End time to 0 and 300, respectively.

This specifies display of the path of air particles for the first 5 minutes they
are in the room.

(f) For Particle color, select Air (mass) from the Variable drop-down list.

This variable is chosen because we are interested in seeing how, or if, the VOCs
produced by the copier are dispersed through the room. Air (mass) is the mass
fraction of air at a certain point in the room. A value less than 1 indicates
the presence of a contaminant, which in this case is benzene.

(g) In the Animation section, enter 300 in the End text field.

(h) Click Animate to update the graphics display.

Figure 3.14 shows the path of air particles entering the room through all of the
openings.

3-28 c© Fluent Inc. May 16, 2007



Copy Machine Emitting Volatile Gases

Figure 3.14: Particle Traces of Air Over 5 Minutes

Summary: In this tutorial, you created a model of an office copier room and determined
the flow patterns in the room, as well as the mass fraction distributions of the
various species involved.
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Tutorial 4. Room and Office Space Created from Imported
IGES Geometry

Introduction: This tutorial demonstrates how to import geometry created using a com-
mercial CAD program into Airpak. Airpak provides the capability to import an Ini-
tial Graphics Exchange Specification (IGES) file, as well as utilities to simplify the
CAD geometry representation and allow the geometry to be represented as Airpak
objects. In this tutorial you will import an IGES file into Airpak. You will then
convert the imported CAD geometry into Airpak objects. Finally, you will obtain
a solution for the Airpak model.

In this tutorial you will learn how to:

• Change the system of units

• Import an IGES file into Airpak

• Convert IGES geometry into Airpak objects

• Delete unwanted CAD geometry

• Edit a group of objects

Prerequisites: This tutorial assumes that you are familiar with the menu structure in
Airpak and that you have solved or read Tutorial 1. Some steps in the setup and
solution procedure will not be shown explicitly.

Problem Description: The model consists of a circular room containing an office cu-
bicle. Other objects in the room include a person, computer, table, cabinet, inlet
fan, and exhaust vent, as shown in the figure below. Air enters the cubicle through
the inlet fan at a mass flow rate of 75 ft3/min.
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Figure 4.1: Problem Specification
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Preparation

1. Copy the file

AIRPAK ROOT/tutorials/room/room.igs

to your working directory. You must replace AIRPAK ROOT by the full path name
of the directory where Airpak is installed on your computer system.

Step 1: Open a New Job and Import the IGES File

1. Start Airpak, as described in Section 1.5 of the User’s Guide.

When Airpak starts, the New/existing panel will open automatically.

2. Click New in the New/existing panel to start a new Airpak project.

The New project panel will appear.

(a) In the Project text box, type /room at the end of the path.

(b) Click Create.

Airpak will create a default room with the dimensions 10 m × 3 m × 10 m, and
display the room in the graphics window.

You can rotate the room around a central point using the left mouse button, or you
can translate it to any point on the screen using the middle mouse button. You can
zoom into and out from the room using the right mouse button. To restore the room
to its default orientation, click on Orient menu and select Home position from the
Orient drop-down list.

3. Specify Imperial (English) units as the default units for the model.

Edit−→Preferences

(a) In the Preferences panel, click the Units node.

Airpak will display the units editor panel.

(b) Click Set all to Imperial.

(c) Click This project in the Preferences panel to apply the unit settings to this
project only and close the panel.

4. Import the IGES file into Airpak.

Model−→CAD data−→Load−→Load IGES/Step file

(a) Select the file room.igs in the Files list.
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Figure 4.2: The Preferences Panel
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(b) Click Open.

5. Click the Orient menu and select Isometric from the drop-down list.

An Isometric view of the imported geometry is shown in Figure 4.3.

Figure 4.3: Geometry Imported from the IGES File

Step 2: Convert the CAD Geometry into Airpak Objects
Now that you have imported the CAD geometry into Airpak, the next step is to convert it
into Airpak objects. You will do this by selecting groups of surfaces and converting them
into Airpak objects.

1. Create a block to represent the person.

In this simplified model, the person will be modeled as a block object.

(a) Use the right mouse button to zoom into the CAD geometry representing the
person and the middle button to translate the view, as shown in Figure 4.4.

Note: The objects will not be highlighted in your display. They are highlighted
in Figure 4.4 to help you identify them in your display more easily.
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Figure 4.4: Close-Up View of the Hexahedral Block Objects

(b) In the CAD data panel, select the shape that you want Airpak to try to fit to
the CAD geometry.

i. Under Shapes to try, deselect Circular, Cylindrical, Inclined, Polygonal, and
Quadrilateral.

This will ensure that the person is created as a rectangular prism block.

(c) Create the person block.

i. Under Create object, select the Blocks object.

ii. Using the left mouse button, click on three of the six surfaces that comprise
the person (shown in Figure 4.4) in the graphics window.

Hint: If you select the wrong CAD geometry, click the right mouse button
in the graphics window to undo your selection.

iii. Click the middle mouse button in the graphics window to complete the
creation of the block.

An Airpak block object will be displayed in the graphics window.

(d) Specify a name for the block.

i. Select FACE in the Model manager window to display the edit panel.

ii. In the Info tab, enter the name person in the Name field.
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iii. Click Update.

2. Create a block to represent the computer.

(a) Under Create object, select the Blocks object.

(b) Using the left mouse button, click on three of the six surfaces that comprise
the computer (shown in Figure 4.4) in the graphics window.

Hint: If you select the wrong CAD geometry, click the right mouse button in
the graphics window to undo your selection.

(c) Click the middle mouse button in the graphics window to complete the creation
of the block.

An Airpak block object will be displayed in the graphics window.

(d) Specify a name for the block.

i. Select FACE in the Model manager window.

ii. In the Info tab, enter the name computer in the Name field.

iii. Click Update.

3. Create a block to represent the desk cabinet.

(a) Under Create object, select the Blocks object.

(b) Using the left mouse button, click on three of the six surfaces that comprise
the desk cabinet (shown in Figure 4.4) in the graphics window.

(c) Click the middle mouse button in the graphics window to complete the creation
of the block.

An Airpak block object will be displayed in the graphics window.

(d) Click the middle mouse button in the graphics window again to exit the Se-
lected –> objects mode.

You need to exit the Selected –> objects mode if you want to use the mouse
for view manipulation (as you will do in the next step).

Extra: Alternatively, you can toggle between manipulating the view of the
room and the Selected –> objects mode using the F9 key. This is useful in
cases where you are creating many of the same type of Airpak objects out
of the existing CAD geometry. Using F9 will prevent you from having to
repeatedly enter and exit the Selected –> objects mode.

(e) Specify a name for the block.

i. Select FACE in the blocks edit panel.

ii. In the Info tab, enter the name desk-cabinet in the Name field.

iii. Click Update.
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4. Create a cylindrical block to represent the table leg.

(a) Use the right mouse button to zoom into the CAD geometry representing the
table leg and the middle button to translate the view, as shown in Figure 4.5.

Figure 4.5: Close-Up View of the Table Leg Block Object

(b) Select the shape that you want Airpak to try to fit to the CAD geometry.

Model−→CAD data

i. Under Try shapes in the CAD import options panel, deselect Hexagonal and
select Cylindrical.

This will ensure that the table leg is created as a cylindrical block.

(c) Create the table leg block.

i. Under Create object, select the Blocks object.

ii. Using the left mouse button, click on the top, the bottom, and the side
of the table leg (shown in Figure 4.5) in the graphics window.

Hint: If you select the wrong CAD geometry, click the right mouse button
in the graphics window to undo your selection.

iii. Click the middle mouse button in the graphics window to complete the
creation of the block.

After a few moments, an Airpak block object will be displayed in the graph-
ics window.
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iv. Click the middle mouse button in the graphics window again to exit the
Selected –> objects mode.

(d) Specify a name for the block.

i. Select FACE in the blocks edit panel.

ii. In the Info tab, enter the name table-leg in the Name field.

iii. Click Update.

5. Create a cylindrical block to represent the room.

(a) Use the right mouse button to zoom out of the CAD geometry representing
the room and the middle button to translate the view, as shown in Figure 4.6.

Figure 4.6: Close-Up View of the Room Block Object

(b) Create the room block.

i. Under Create object, select the Blocks object.

ii. Using the left mouse button, click on the top, the bottom, and the side
of the room (shown in Figure 4.6) in the graphics window.

Hint: If you select the wrong CAD geometry, click the right mouse button
in the graphics window to undo your selection.

iii. Click the middle mouse button in the graphics window to complete the
creation of the block.
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After a few moments, an Airpak block object will be displayed in the graph-
ics window.

iv. Click the middle mouse button in the graphics window again to exit the
Selected –> objects mode.

(c) Specify a name for the block.

i. Select FACE in the blocks edit panel.

ii. In the Info tab, enter the name fluid-room in the Name field.

iii. Click Update.

6. Create an inlet fan using the CAD geometry.

(a) Use the right mouse button to zoom into the CAD geometry representing the
fan and the middle button to translate the view, as shown in Figure 4.7.

Figure 4.7: Close-Up View of the Fan Object

(b) Select the shape that you want Airpak to try to fit to the CAD geometry.

i. Under Shapes to try in the CAD data panel, deselect Cylindrical and select
Circular.

This will ensure that the fan is created as a circle.

(c) Create the inlet fan.

i. Under Create object, select the Fans object.
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ii. Using the left mouse button, click on the circle that comprises the inlet
fan (shown in Figure 4.7) in the graphics window.

Hint: If you select the wrong CAD geometry, click the right mouse button
in the graphics window to undo your selection.

iii. Click the middle mouse button in the graphics window to complete the
creation of the fan.

An Airpak fan object will be displayed in the graphics window.

iv. Click the middle mouse button in the graphics window again to exit the
Selected –> objects mode.

(d) Specify a name for the fan.

i. Select FACE in the fans edit panel.

ii. In the Info tab, enter the name floor-diffuser in the Name field.

iii. Click Update.

7. Create an exhaust vent using the CAD geometry.

(a) Use the right mouse button to zoom into the CAD geometry representing the
vent and the middle button to translate the view, as shown in Figure 4.8.

Figure 4.8: Close-Up View of the Vent Object

(b) Select the shape that you want Airpak to try to fit to the CAD geometry.

c© Fluent Inc. May 16, 2007 4-11



Room and Office Space Created from Imported IGES Geometry

i. Under Shapes to try in the CAD data panel, deselect Circular and select
Quadrilateral.

This will ensure that the vent is created as a rectangle.

(c) Create the exhaust vent.

i. Under Create object, select the Vents object.

ii. Using the left mouse button, click on the rectangle that comprises the
exhaust vent (shown in Figure 4.8) in the graphics window.

iii. Click the middle mouse button in the graphics window to complete the
creation of the vent.

An Airpak vent object will be displayed in the graphics window.

iv. Click the middle mouse button in the graphics window again to exit the
Selected –> objects mode.

(d) Specify a name for the vent.

i. Select FACE in the vents edit panel.

ii. In the Info tab, enter the name exhaust-vent in the Name field.

iii. Click Update.

8. Create a doorway.

(a) Use the right mouse button to zoom into the CAD geometry representing the
doorway and the middle button to translate the view, as shown in Figure 4.9.

(b) Create the doorway.

i. Under Create object, select the Openings object.

ii. Using the left mouse button, click on the rectangle that comprises the
doorway (shown in Figure 4.9) in the graphics window.

iii. Click the middle mouse button in the graphics window to complete the
creation of the opening.

An Airpak opening object will be displayed in the graphics window.

iv. Click the middle mouse button in the graphics window again to exit the
Selected –> objects mode.

(c) Specify a name for the opening.

i. Select FACE in the openings edit panel.

ii. In the Info tab, enter the name doorway in the Name field.

iii. Click Update.

9. Create two walls using the CAD geometry.

4-12 c© Fluent Inc. May 16, 2007



Room and Office Space Created from Imported IGES Geometry

Figure 4.9: Close-Up View of the Opening Object

(a) Use the right mouse button to zoom out of the CAD geometry representing
the walls and the middle button to translate the view, as shown in Figure 4.10.

(b) Create the first wall.

i. Under Create objects, select the Walls object.

ii. Using the left mouse button, click on the rectangle that comprises the
first wall in the graphics window, identified as wall-1 in Figure 4.10.

iii. Click the middle mouse button in the graphics window to complete the
creation of the wall.

An Airpak wall object will be displayed in the graphics window.

(c) Specify a name for the wall.

i. Select FACE in the walls edit panel.

ii. In the Info tab, enter the name wall-1 in the Name field.

iii. Click Update.

(d) Repeat steps (c) and (d) for the second wall (wall-2).

(e) Click the middle mouse button in the graphics window to exit the Selected –>
objects mode

10. Create cubicle partitions using the CAD geometry.
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Figure 4.10: Close-Up View of the Wall Objects

(a) Use the right mouse button to zoom into the CAD geometry representing the
partitions and the middle button to translate the view, as shown in Figure 4.11.

(b) Create the low partition.

i. Under Create object, select the Partitions object.

ii. Using the left mouse button, click on the rectangle that comprises the low
partition in the graphics window, identified as low-partition in Figure 4.11.

iii. Click the middle mouse button in the graphics window to complete the
creation of the partition.

An Airpak partition object will be displayed in the graphics window.

(c) Specify a name for the partition.

i. Select FACE in the partitions edit panel.

ii. In the Info tab, enter the name low-partition in the Name field.

iii. Click Update.

(d) Repeat steps (c) and (d) for the remaining three partitions (hi-partition-1,
hi-partition-2, and hi-partition-3).

(e) Click the middle mouse button in the graphics window to exit the Selected –>
objects mode.

11. Create rectangular tabletops using the CAD geometry.
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Figure 4.11: Close-Up View of the Partition Objects

(a) Click the Orient menu and select Negative Y from the drop-down list.

(b) Use the right mouse button to zoom into the CAD geometry representing the
partitions and the middle button to translate the view, as shown in Figure 4.12.

(c) Create two rectangular tabletops.

For simplicity, in this step you will split a single L-shaped CAD surface into
two Airpak partition objects.

i. Under Creation mode in the CAD data panel, select Region.

ii. Using the left mouse button, click on the L-shaped object that comprises
the tabletop (shown in Figure 4.12) in the graphics window.

iii. Click the middle mouse button in the graphics window to accept the
selection of the tabletops.

iv. Position the mouse pointer (which is now a “+”) on the line just beneath
the block representing the person and press the h key on the keyboard to
draw a horizontal line.

v. Click the middle mouse button in the graphics window to accept the
division of the region.

Airpak will open the Multiple regions panel.

vi. Click Split to split the region into two partitions.

Two Airpak partition objects will be displayed in the graphics window.
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Figure 4.12: Close-Up View of the Rectangular Tabletop Objects

vii. Click the middle mouse button in the graphics window again to exit the
Regions –> objects mode.

(d) Specify names for the partitions.

i. Select FACE in the partitions edit panel.

ii. In the Info tab, enter the name tabletop-1 in the Name field.

iii. Click Update.

iv. Repeat steps i–iii for FACE.1 (tabletop-2).

12. Create a circular tabletop.

(a) Click on the Orient menu and select Isometric from the Orient drop-down list.

(b) Use the right mouse button to zoom into the CAD geometry representing the
circular tabletop and the middle button to translate the view, as shown in
Figure 4.14.

(c) Select the shape that you want Airpak to try to fit to the CAD geometry.

Model−→CAD data

i. Under Shapes to try in the CAD data panel, deselect Quadrilateral and
select Circular.

This will ensure that the tabletop is created as a circle.
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Figure 4.13: Multiple Regions Panel

Figure 4.14: Close-Up View of the Circular Tabletop Object
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ii. Under Creation mode, click Selected.

(d) Create the tabletop.

i. Under Create object, select the Partitions object.

ii. Using the left mouse button, click on the circle that comprises the tabletop
(shown in Figure 4.14) in the graphics window.

iii. Click the middle mouse button in the graphics window to complete the
creation of the tabletop.

An Airpak partition object will be displayed in the graphics window.

iv. Click the middle mouse button in the graphics window again to exit the
Selected –> objects mode.

(e) Specify a name for the tabletop.

i. Select FACE in the partitions edit panel.

ii. In the Info tab, enter the name tabletop-3 in the Name field.

iii. Click Update.

13. Remove all of the remaining CAD geometry from your Airpak model.

Model−→CAD data−→Clear

(a) Select the Model menu and click CAD data to display the CAD data panel.

(b) Click Clear to remove all existing unused cad data.
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Step 3: Create Other Airpak Objects
To complete the model, you will now create additional Airpak objects, including “dead”
block objects, as well as a floor and a ceiling. “Dead” blocks are created to represent
spaces within the room that are not to be meshed. The regular room object must bound
the entire problem, but the domain of interest in this tutorial does not completely fill the
rectangular room object.

1. Create the first dead block.

(a) Click in the object toolbar.

Airpak will create a new hollow prism block in the center of the room. You will
need to change both the size of the block and its location within the room.

(b) Double click block.1 to display the Blocks edit panel.

(c) Enter the following coordinates:

xS 10 xE 24

yS 0 yE 8

zS 0 zE 14

(d) In the Info tab, enter the name dblock in the Name field.

(e) Click Update to modify the block.

2. Create the first of four dead blocks to occupy the corners of the rectangular room
object.

(a) Click in the object toolbar.

(b) Enter the following coordinates:

xS -4 xE 1

yS 0 yE 8

zS -14 zE 14

(c) In the Info tab, enter the name dead-block-1 in the Name field.

(d) Click Done to update the block and close the Blocks panel.

3. Copy dead-block-1 to create a second dead block on the opposite side of the room.

(a) Select dead-block-1 in the Model manager window.

(b) Right mouse click to display the context menu.

(c) Click Copy object.

Airpak will open the Copy block dead-block-1 panel.

(d) Select Translate and enter 23 next to X offset.

(e) Retain the default Y offset and Z offset of 0.
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(f) Click Apply to generate the new block and close the panel.

An additional block will now appear in the graphics display that is identical to
the first and offset by 23 ft in the x direction.

4. Create the third of four dead blocks to mask the corners of the rectangular room
object.

(a) Click in the object toolbar.

(b) Modify the default block in the Blocks panel.

(c) Enter the following coordinates:

xS -4 xE 24

yS 0 yE 8

zS -14 zE -9

(d) In the Info tab, enter the name dead-block-2 in the Name field.

(e) Click Done to update the block and close the Blocks panel.

5. Copy dead-block-2 to create the fourth dead block on the opposite side of the room.

(a) Select dead-block-2 in the Model manager window.

You will need to use the scroll bar to access this object.

(b) Click Copy object in the context menu.

Airpak will open the Copy block dead-block-2 panel.

(c) Under Translate, set X offset and Y offset to 0.

(d) Set Z offset to 23.

(e) Click Apply to generate the new block and close the panel.

An additional block will now appear in the graphics display that is identical to
the first and offset by 23 ft in the z direction.

6. Create a group containing the four similar dead blocks.

(a) Enter the name invis-blocks in the Name for new group field.

(b) Click Done.

(c) Select the invis-blocks under the Groups node and right mouse click to display
the context menu.

(d) Select Add and select Name/pattern from the drop-down list.

Airpak will open the Pattern for objects to add panel.

i. Enter dead as the Pattern for objects to add.
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ii. Click Done

dead-block-1, dead-block-1.1, dead-block-2, and dead-block-2.1 will be added
to the Objects in the group list.

(e) In the Group parameters panel, next to Shading, select Invisible from the drop-
down list.

(f) Select Accept.

The four objects in the group will disappear from the graphics window.

7. Create the room floor.

(a) Click in the object toolbar.

(b) Modify the default wall in the Walls panel.

(c) Change the Plane to X-Z.

(d) Enter the following coordinates:

xS -4 xE 24

yS 0 yE —–
zS -14 zE 14

(e) In the Info tab, enter the name floor in the Name field.

(f) Click Done to update the wall and close the Walls panel.

8. Copy the floor to create the room ceiling.

(a) Select floor.

(b) Click Copy object in the context menu.

Airpak will open the Copy wall floor panel.

(c) Under Translate, set Y offset to 8.

(d) Set X offset and Z offset to 0.

(e) Click Apply to generate the new wall and close the panel.

An additional wall will now appear in the graphics display that is identical to
the first and offset by 8 ft in the y direction.

(f) In the Info tab of the Walls edit panel, enter the name ceiling in the Name
field.

(g) Click Update.

Step 4: Define Problem Setup Parameters
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Figure 4.15: Species Definitions Panel

1. Modify the overall problem description to include the effects of the ideal gas law,
radiation, and species mixing.

Problem setup−→ Basic parameters

(a) Next to Species, select On and click Edit.

Airpak will open the Species definitions panel.

i. Set the Initial concentration of h2o to 50.

ii. Select RH from the menu to the right of the Initial concentration field for
h2o.

RH is the relative humidity of the air in the room specified as a percentage.

iii. Click Accept.
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(b) In the General setup tab, in the Basic parameters panel, turn on the Discrete
ordinates radiation model.

The discrete ordinates radiation model is used instead of the surface-to-surface
radiation model because the model objects are nearly all contained within the
fluid-room block object and the view factor calculation method is not able to
“see” objects that are inside other objects.

(c) Click the Advanced tab.

i. Turn on the Ideal gas law and the Oper. density and keep the default values
for operating pressure and density.

(d) Under Ambient values in the Default values tab, set the Temperature to 80◦F.

(e) Under Initial conditions, set the Temperature to ambient.

(f) Click Accept to close the Basic parameters panel.
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Step 5: Set Parameters for Airpak Objects

1. Resize the imported room.

By adjusting the position of certain objects in the model, you will ensure that a
better-quality mesh will be generated in later steps.

Model−→Room

(a) In the Room edit panel, enter a value of 0 for yS.

(b) Click Done to resize the room.

2. Resize the rectangular tabletops.

(a) Adjust the position of tabletop-1.

i. Select tabletop-1 in the Model manager window.

ii. Enter a value of 2.5 for zE.

iii. Click Done to resize the partition.

(b) Adjust the position of tabletop-2

i. Select tabletop-2 in the Model manager window.

ii. Enter a value of 2.5 for zS.

iii. Click Done to resize the partition.

3. Set parameters for the cylindrical room block.

(a) Select fluid-room in the Model manager window.

i. In the Properties tab next to Block type, select Fluid.

ii. Turn on the Surface specification option.

iii. Turn on the Individual sides option and click Edit.

Airpak will open the Individual side specification panel.

iv. Turn on the Thermal properties option for Bottom, Top and Sides and keep
the default parameters. See Figure 4.16.

v. Click Update.

vi. Click Done in the Blocks panel to modify the block.
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Figure 4.16: Individual Side Specification Panel
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Figure 4.17: Species Concentrations Panel

4. Set parameters for the computer.

(a) Select computer in the Model manager panel.

(b) In the Blocks panel, set the Total power to 0.1896 BTU/s.

(c) Click Done in the Blocks panel to modify the block.

5. Set parameters for the person.

(a) Select person in the Model manager panel.

(b) In the Blocks panel, set the Total power to 0.0948 BTU/s.

(c) Click Done in the Blocks panel to modify the block and close the panel.

6. Set parameters for the inlet fan.

(a) Select floor-diffuser in the Fans edit panel.

(b) In the Properties tab, set the Fluid temp to 60◦F.

(c) Under Flow rate, set the Volume to 75 ft3/min.

(d) Select the Species option and click Edit.

Airpak will open the Species concentrations panel (Figure 4.17).

i. Enter a value of 50 for the Concentration of h2o.

ii. Select RH from the menu to the right of the Concentration field for h2o.

iii. Click Done.

(e) Click Done in the Fans panel to modify the fan and close the panel.

7. Set parameters for the doorway.

(a) Select doorway in the Model manager window.

(b) In the Properties tab, turn on the options for Static press and Temperature.

(c) Turn on the Species option and click Edit.

Airpak will open the Species concentrations panel (Figure 4.18).
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Figure 4.18: Species Concentrations Panel

i. Enter a value of 75 for the Concentration of h2o.

ii. Select RH from the menu to the right of the Concentration field for h2o.

iii. Click Done.

(d) Click Done in the Openings panel to modify the opening and close the panel.

The completed Airpak model is shown in Figure 4.19.

Figure 4.19: Model of Room with Office, Fan, Vent, Walls, and Doorway
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8. Check the model to be sure that there are no problems (e.g., objects that are too
close together to allow for proper mesh generation).

Model−→Check model

Airpak should report in the Message window that 0 problems were found and that
all tolerances are acceptable.

9. Check the definition of the modeling objects to ensure that you specified them
properly.

View−→Summary (HTML)

Airpak will list the specifications for all modeling objects in a web browser which
can be launched from selecting the View menu and clicking Summary (HTML). You
can check them here and if you notice any incorrect specifications, you can change
them in the object’s edit panel.
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Step 6: Generate a Mesh
You will generate the mesh in two steps. First you will modify the order in which objects
are meshed. Then you will create a mesh and examine it.

1. Change the meshing priority of the dead blocks and the room block.

Objects in the model that are contained within another object (e.g., person is inside
of fluid-room) must have a higher meshing priority than the surrounding object so
that they will be included in the mesh. You will need to change the order in which
the objects in the room are meshed so that all objects contained within fluid-room
will be “seen” by the meshing tool.

Model−→Edit priorities

(a) In the Object priority panel, enter a value of 0 for dead-block-1, dead-block-1.1,
dead-block-2, and dead-block-2.1.

You may need to use the scroll bar to access these objects.

(b) Enter a value of 1 for fluid-room.

(c) Enter a value of 100 for dblock.

(d) Click Accept to modify the priorities and close the panel.

2. Set the meshing parameters.

Model−→Generate mesh

(a) Set the Max X size, Max Y size, and Max Z size to 1.

(b) Set object-specific meshing parameters for the table leg.

i. Select Object params and click Edit.

Airpak will open the Per-object mesh parameters panel.

ii. In the Per-object mesh parameters panel, turn on table-leg.

iii. Click Use per-object parameters.

iv. Select Diameter count.

v. Under Requested, enter 8 for Diameter count.

The table-leg will appear in red indicating that meshing parameters have
been set for this object.

(c) Set object-specific meshing parameters for the floor diffuser.

i. In the Per-object mesh parameters panel, turn on floor-diffuser.

ii. Click Use per-object parameters.

iii. Select Diameter count.

iv. Under Requested, enter 8 for Diameter count.
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(d) Set object-specific meshing parameters for the doorway.

i. In the Per-object mesh parameters panel, turn on doorway.

ii. Click Use per-object parameters.

iii. Select X count and Y count.

iv. Under Requested, enter 5 for X count and Y count.

(e) Set object-specific meshing parameters for the circular tabletop.

i. In the Per-object mesh parameters panel, turn on tabletop-3.

ii. Click Per-object mesh parameters.

iii. Select Diameter count.

iv. Under Requested, enter 12 for Diameter count.

(f) In the Per-object mesh parameters panel, click Done to save all the object-
specific meshing parameters and close the panel.

3. Click the Generate mesh button in the Mesh control panel to generate a mesh.

Note: Airpak may recommend more small adjustments to the position of objects
in the room so that a better-quality mesh will be generated. If any Small gaps
panels appear, click Accept in each one.

4. Examine the mesh on a y-z cross-section of the model.

(a) Select Display at the top of the Mesh control panel.

The panel will be updated to show the mesh display tools.

(b) Turn on the Cut plane option.

(c) Select Point and normal next to Set position.

(d) Set (PX, PY, PZ) to (2.8, 0, 0) and set (NX, NY, NZ) to (1, 0, 0).

These settings will result in a mesh display on a y-z plane passing through the
point (2.8, 0, 0).

(e) Turn on the Display mesh option.

The mesh display plane is perpendicular to the ceiling, as shown in Fig-
ure 4.20.

(f) Click on the two square boxes next to Cut plane to advance the plane cut
through the model.

5. Turn off the mesh display.

(a) Deselect the Display mesh option.

(b) Click Close to close the Mesh control panel.
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Figure 4.20: Mesh on a y-z Plane
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Step 7: Check the Flow Regime
Before starting the solver, you will first review estimates of the Reynolds and Peclet
numbers to check that the proper flow regime is being modeled.

1. Check the values of the Reynolds and Peclet numbers.

Solve−→Settings−→Basic

(a) Click the Reset button.

(b) Check the values printed to the Message window.

The Reynolds and Peclet numbers are approximately 13000 and 10000, respec-
tively, so the flow is turbulent. Since you are currently modeling turbulent
flow, no changes are required. The Message window will also report that the
initial air velocity has been reset to −10−4 times gravity. This modification
improves the convergence of natural convection calculations.

(c) Click Accept to save the new solver settings.

Step 8: Save the Model to a Job File
Airpak will save the model for you automatically before it starts the calculation, but it is
a good idea to save the model (including the mesh) yourself as well. If you exit Airpak
before you start the calculation, you will be able to open the job you saved and continue
your analysis in a future Airpak session. (If you start the calculation in the current Airpak
session, Airpak will simply overwrite your job file when it saves the model.)

File−→Save Project

Step 9: Calculate a Solution

1. Increase the Number of iterations to 500.

Solve−→Settings−→Basic

2. Modify the parameters for the solver.

Solve−→Settings−→Advanced

(a) In the Advanced solver setup panel, enter the following values for Under-relaxation.

• Pressure: 0.7

• Momentum: 0.3
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• Retain the defaults for Temperature, Viscosity, Body forces, and h2o.

(b) Click Accept to store the settings and close the Advanced solver setup panel.

3. Start the calculation.

Solve−→Run Solution

(a) Keep the default settings in the Solve panel.

(b) Click Start solution to start the solver.

The calculation will converge after about 160 iterations. In the window where
the residual values are printed, the calculation will continue after the residual
plot stops, as the equations for radiation and mean age of air are solved. When
the solution is completed, you can close the Monitor window by clicking Done.

If you do not want to wait for the calculation to finish, you can save time by
reading in the results provided in the tutorials directory and then following
the instructions (in the next step of this tutorial) for examining the results.
See the preface (Using This Manual) for details.

Step 10: Examine the Results

1. Display velocity vectors on a horizontal plane cut through the room.

Post−→Plane cut

(a) In the Name field, enter the name velocity-vectors.

(b) Select of Point and normal for the plane specification.

(c) Specify the point (PX, PY, PZ) as (0, 2, 0), and the normal (NX, NY, NZ)
as (0, 1, 0).

This defines a cross-section in the x-z plane, passing through the point (0, 2,
0).

(d) Select Show vectors.

(e) Click Create.

In Figure 4.21, you can see the flow distribution of air at a range of velocities
throughout the room.
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Figure 4.21: Velocity Vectors in an x-z Cross-Section
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(f) Turn off the Active option and click Done.

This will temporarily remove the velocity vector display from the graphics win-
dow, so that you can more easily view the next postprocessing object.

2. Display contours of temperature on block objects in the room.

Post−→Object face

(a) Display temperature contours on the person block.

i. In the Name field in the Object face panel, enter the name tcont-person.

ii. In the Object drop-down list, select person.

iii. Select Show contours.

iv. Click Create.

(b) Display temperature contours on the computer block.

i. Click New in the Object face panel.

ii. In the Name field, enter the name tcont-computer.

iii. In the Object drop-down list, select computer.

iv. Select Show contours.

v. Click Create.

(c) Display temperature contours on the desk cabinet block.

i. Click New in the Object face panel.

ii. In the Name field, enter the name tcont-desk-cabinet.

iii. In the Object drop-down list, select desk-cabinet.

iv. Select Show contours.

v. Click Create.

(d) Display temperature contours on the table leg block.

i. Click New in the Object face panel.

ii. In the Name field, enter the name tcont-table-leg.

iii. In the Object drop-down list, select table-leg.

iv. Select Show Contours.

v. Click Create.

Figure 4.22 shows temperature contours on the group of four blocks in the
room.

(e) Turn off each temperature contour display.

i. In the postprocessing node, select tcont-person.

ii. Turn off the Active option in the context menu.

c© Fluent Inc. May 16, 2007 4-35



Room and Office Space Created from Imported IGES Geometry

Figure 4.22: Temperature Contours on Block Objects in the Room

iii. Repeat steps i–ii for tcont-computer, tcont-desk-cabinet, and tcont-table-
leg.

This will temporarily remove the temperature contours from the graphics win-
dow, so that you can more easily view the next postprocessing object.

3. Examine the flow of air particles through the room.

You will trace the path of air particles entering the room through the floor diffuser
and through the doorway.

(a) Display particles entering through the floor diffuser Post−→Object face

i. Click New in the Object face panel.

ii. In the Name field, enter the name particle-trace-fan.

iii. In the Object drop-down list, select fan.

iv. Select Show particle traces and click Parameters.

Airpak will open the Object face particles panel.

v. In the Particle trace attributes panel, enter 0 for the Start time, 200 for the
End time.

vi. Under Display options, enter 25 next to Uniform.

vii. Click Done to close the panel and begin the trace.
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Figure 4.23: Object Face Particles Panel
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(b) Display particles entering through the doorway.

i. Click New in the Object face panel.

ii. In the Name field, enter the name particle-trace- opening.

iii. In the Object drop-down list, select doorway.

iv. Select Show particle traces and click Parameters.

Airpak will open the Object face particles panel.

v. In the Particle trace attributes panel, enter 0 for the Start time, 200 for the
End time.

vi. Under Display options, enter 25 next to Uniform.

vii. Click Done to close the panel and begin the trace.

Figure 4.24 shows the path of the air particles emitted from the floor diffuser
and flowing from the doorway.

Figure 4.24: Particle Trace of Air Through the Room

Summary: In this tutorial, you imported an IGES file into Airpak and converted the
CAD geometry into Airpak objects. After solving the problem, you examined tem-
perature contours and the flow of air through the room.
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Tutorial 5. High Density Datacenter Cooling

Introduction: This tutorial demonstrates how to model a datacenter using Airpak.

In this tutorial, you will learn how to:

• Open a new project

• Use blocks, fans, recirculation openings, vents, planar and volumetric resis-
tances, partitions to represent air conditioning units (CRACs), server cabinets,
power distribution units (PDUs), perforated floor tiles, raised floor, blockages,
ceiling plenum and return grilles in the datacenter.

• Use copying and grouping functionalities to expedite model building

• Include effects of gravity and turbulence in the simulation

• Modify the minimum object separation value for meshing

• Define object-specific meshing parameters

• Modify solution setup parameters such as underrelaxation settings and maxi-
mum number of iterations

• Calculate a solution

• Create contours, particle traces, iso-surfaces to better understand the airflow
patterns and temperature stratification within the datacenter space

Prerequisites: This tutorial assumes that you are familiar with the menu structure in
Airpak and that you have solved or read Tutorial 5. Some steps in the setup and
solution procedure will not be shown explicitly.

Problem Description: The tutorial considers a 1200 sq. ft. datacenter with a slab
to slab height of 12 ft as shown in Figure 5.1. The datacenter consists of a 1.5
ft under floor plenum and a 2 ft ceiling plenum. The CRACs discharge cold air
into the underfloor plenum. The cold air enter the main datacenter space mainly
through the perforated floor tiles and returns back to the air conditioning units as
shown in Figure 5.2. The cooling load, as summarized in Table 5.0.1 corresponds
to the heat output from the server cabinets and the PDUs.
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Table 5.0.1: Size and Capacity of Heat Sources in Datacenter

Heat Source Size Power
Server Cabinet 2 ft × 3 ft × 7 ft 3000 W
High Density Server Cabinet 2 ft × 3 ft × 7 ft 7000 W
PDU 4 ft × 2 ft × 5 ft 3600 W

Figure 5.1: Geometry of the Datacenter Model

Figure 5.2: Expected Airflow Path
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Step 1: Open and Define a New Job

1. Start Airpak, as described in Section 1.5 of the User’s Guide.

When Airpak starts, the New/existing panel will open automatically.

2. Click New in the New/existing panel to start a new Airpak project.

The New project panel will appear.

3. Specify a name for your project in the Project text box.

You can enter the name datacenter.

4. Click Create.

Airpak will create a default room with dimensions 10 m × 3 m × 10 m, and display
the room in the graphics display window.

You can rotate the room around a central point using the left mouse button, or you
can translate it to any point on the screen using the middle mouse button. You can
zoom into and out from the room using the right mouse button. To restore the room
to its default orientation, click on the Orient menu and select Home position.

5. Set the default dimension editing option to Start/length.

Edit−→Preferences−→Options−→Editing−→Default dimensions−→Start/length
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Figure 5.3: Default Dimensions Option in the Preferences Panel
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6. Turn off Decoration for all object types and update line Width to 2 for blocks, fans,
vents, openings, partitions, and resistances.

Figure 5.4: The Preferences Panel (Object Types)

7. Set the Imperial Unit System for this problem.

Edit−→Preferences−→Defaults−→Units−→Set all to Imperial
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Figure 5.5: The Preferences Panel (Units)
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8. Set the meshing defaults.

Edit−→Preferences−→Defaults−→Meshing

Set the Minimum object separation values in X, Y and Z to be 1 inch.

Figure 5.6: The Preferences Panel (Meshing)
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9. Set the default underrelaxation setting for Momentum to 0.2

Edit−→Preferences−→Defaults−→Solution

Figure 5.7: The Preferences Panel (Defaults)

10. Confirm the above changes for the current project.

Edit−→Preferences−→This project
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11. Modify the overall problem definition to

(a) Include the effects of gravity

(b) Exclude the radiation and IAQ/Thermal comfort calculations

(c) Use the Zero Equation Turbulence model

(d) Set a non-zero initial condition for Y-velocity (recommended for problems
involving natural convection)

(e) Turn on the ideal gas law (recommended for problems involving significant
temperature differences)

Problem setup−→ Basic parameters

Figure 5.8: The Basic parameters Panel (General Setup Tab)
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Figure 5.9: The Basic parameters Panel (Default Values Tab)
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Figure 5.10: The Basic parameters Panel (Advanced Tab)

12. Keep the default settings for all other parameters in the Basic parameters panel.

13. Click Accept to save the new settings.

14. Save the project using File−→Save Project.
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Step 2: Build the Model
To build the model, you will first resize the room to its proper size. Then you will create
the features of the room, including CRACs (2), server cabinets (44), perforated floor tiles
(44), raised floor (1), dropped ceiling (1), return grilles (8), PDUs (2), cable trays (4),
columns (2) and miscellaneous blockage (1).

1. Resize the default room.

Double click Room in the Model manager window to open the edit panel for the
Room. Resize the room as shown below.

(a) In the Room panel, enter the coordinates as shown in the following figure.

(b) Click Update to resize the room.

(c) Click Done to update the room and close the panel.

(d) Click from the Orient toolbar to show an isometric view of the room
scaled to fit the graphics window.

Note: The walls of the room are adiabatic and do not participate in radiation, by
default. Radiation will not be considered for this analysis.
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Figure 5.11: Isometric View of the Room
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2. Create the raised floor.

(a) Click icon in the object toolbar.

Airpak will create a new partition in the center of the room. You will need
to change the size and orientation of the partition and its location within the
room.

(b) Display the Partitions edit panel by doing one of the following:

• Double click partition.1 in the Model manager window.

• Select partition.1 from the Model manager window and right mouse click
to display the context menu. Select Edit object.

(c) In the Info tab, enter raisedfloor in the Name field and click Update.

(d) In the Geometry tab, change the plane to X-Z and enter the following coordi-
nates for the partition raisedfloor,

xS = 0 ft xL = 40 ft
yS = 1.5 ft yL = ----

zS = 0 ft zL = 30 ft

(e) Click Done to update the partition and close the panel.
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Figure 5.12: Display of raisedfloor in the Graphics Display Window
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3. Create the first CRAC unit.

(a) Click icon in the object toolbar.

Airpak will create a new hollow block in the center of the room. You will need
to change the size of the block and its location within the room.

(b) Display the Blocks edit panel by double clicking block.1 in the Model manager
window.

(c) In the Info tab, enter crac1 in the Name field and CRACs in the Groups field
and click Update.

(d) In the Geometry tab, enter the following coordinates for the block crac1,

xS = 0 ft xL = 2 ft
yS = 1.5 ft yL = 6 ft

zS = 8 ft zL = 4 ft

(e) Click Done to update the block and close the panel.

(f) Click icon in the object toolbar.

Airpak will create a new circular fan in the center of the room. You will need
to change the geometry, size, and orientation of the fan and its location within
the room.

(g) Display the Fans edit panel by double clicking on fan.1 in the Model manager
window.

(h) In the Info field, enter crac1-sup in the Name field and CRACs in the Groups
field and click Update.

(i) In the Geometry tab, change the geometry to Rectangular, change the Plane to
X-Z and enter the following coordinates for the crac1-sup.

xS = 0 ft xL = 2 ft
yS = 1.5 ft yL = ----

zS = 8 ft zL = 4 ft

(j) In the Properties tab, specify the fluid temperature to be 55 degrees F and the
mass flow rate to be 15.9 lbm/s as shown below.
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Figure 5.13: The crac1-sup Properties Tab
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(k) Click Update to update the fan.

(l) Click New in the Fans edit panel to create a new fan.

(m) Display the Fans edit panel by double clicking fan.1 in the Model manager
window.

(n) In the Info tab, enter crac1-ret in the Name field and CRACs in the Groups
field and click Update.

(o) In the Geometry tab, change the geometry to Rectangular, Plane to X-Z and
enter the following coordinates for the fan crac1-ret.

xS = 0 ft xL = 2 ft
yS = 7.5 ft yL = ----

zS = 8 ft zL = 4 ft

(p) In the Properties tab, modify the fan to be of the Exhaust type and specify the
mass flow rate to be 15.9 lbm/s as shown below.
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Figure 5.14: The crac1-ret Properties Tab
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Figure 5.15: crac1-ret in the Graphics Display Window

(q) Click Done to update the fan and close the panel.

(r) Set the object-specific meshing parameters for the fans crac1-sup and crac1-ret.

i. Open the Mesh Control panel using the Model menu and clicking on Gen-
erate Mesh.

ii. Check the Object params option and click Edit to open the Per-object
meshing parameters panel.

iii. Select the fan crac1-ret from the list and check the Use per-object pa-
rameters option.

iv. Specify 4 for x count and Z count under Requested.

v. Similarly, specify 4 for x count and Z count under Requested for the fan
crac1-sup as well.

(s) Click Done to close the Per-object meshing parameters panel.

(t) Click Close to close the Mesh control panel.
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Figure 5.16: Per-Object Meshing Parameters for crac1-sup
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4. Create the second CRAC unit.

(a) Open the Groups node in the Model manager window by clicking the + sign
next to Groups.

(b) Right click on the group CRACs to display the context menu.

(c) Select Copy group to display the Copy group CRACs panel.

(d) Set the Number of copies to 1.

(e) Check the Group name option and enter CRACs in the Group name field.

(f) Check the Translate option and set the Z offset to 10 ft.

(g) Click Apply. The display will be updated to show the second CRAC unit.

(h) Click Done to close the panel.
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Figure 5.17: crac1-ret and crac1-ret.1 in the Graphics Display Window

(i) Save the project using File−→Save Project.
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5. Create a server rack.

(a) Click icon in the object toolbar.

(b) Display the Blocks edit panel by double clicking block.1 in the Model manager
window.

(c) In the Info tab, enter rack1 in the Name field and RACKs in the Groups field
and click Update.

(d) In the Geometry tab, enter the following coordinates for the block rack1.

xS = 8 ft xL = 3 ft
yS = 1.5 ft yL = 7 ft

zS = 4ft zL = 2 ft

(e) Click Done to update the block and close the panel.

(f) Click icon in the object toolbar.

(g) Display the Openings edit panel by double clicking on opening.1 in the Model
manager window.

(h) In the Info tab, enter rack1-flow in the Name field and RACKs in the Groups
field.

(i) In the Geometry field, select Recirc as the Type, select Plane Y-Z, and enter
the following coordinates for the Supply section of the recirculation opening
rack1-flow. Click Update to save your changes.

xS = 8 ft xL = ----

yS = 1.5 ft yL = 7 ft
zS = 4 ft zL = 2 ft

(j) In the Geometry tab, select Plane Y-Z and enter the following coordinates for
the Extract section of the recirculation opening rack1-flow.

xS = 11 ft xL = ----

yS = 1.5 ft yL = 7 ft
zS = 4 ft zL = 2 ft

(k) In the Properties tab, enter the volumetric flow rate of 450 cfm and a heat
input of 3000 W as shown below.
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(l) Click Done to update the opening and close the panel.

Note: The volumetric flow rate input for the recirculation opening is con-
verted by Airpak to a mass flow rate input to the computational stage of
the analysis. For this conversion, Airpak uses the density specified for Air
in the materials panel shown below. It is important to appropriately up-
date this density field to correctly account for the effect of altitude on air
density.
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6. Create a row of 11 server racks.

(a) Right click on the group RACKs to display the context menu.

(b) Select Copy group to display the Copy group RACKs panel.

(c) Set the Number of copies to 10.

(d) Check the Group name option and enter RACKs in the group Name field.

(e) Check the Translate option and set the Z offset to 2 ft.

(f) Click Apply. The display will be updated to show the row of 11 racks.

(g) Click Done to close the panel.

Figure 5.18: 11 Server Racks in the Graphics Display Window
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(h) Switch the visibility of the object names to the Selected option.

View−→Display−→Object names−→Selected

(i) Save the project using File−→Save Project.

Figure 5.19: Selected Object Name
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7. Create a second row of server racks.

(a) Right click on the group RACKs to display the context menu.

(b) Select Copy group to display the Copy group RACKs panel.

(c) Set the Number of copies to 1.

(d) Check the Group name option and enter RACKs in the group Name field.

(e) Check the Rotate option and set the Axis to the y Axis and the Degrees to 180.

(f) Check the Translate option and set the x offset to 7 ft.

(g) Click Apply. The display will be updated to show the additional row of racks.

(h) Click Done to close the panel.

(i) Save the project using File−→Save Project.

Figure 5.20: Second Row of Server Racks in the Graphics Display Window
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8. Create a high density server rack.

(a) Click icon in the object toolbar.

(b) Display the Blocks edit panel by double clicking block.1 in the Model manager
window.

(c) In the Info tab, enter hdrack1 in the Name field and HDRACKs in the Groups
field and click Update.

(d) In the Geometry tab, enter the following coordinates for the hdrack1.

xS = 22 ft xL = 3 ft
yS = 1.5 ft yL = 7 ft

zS = 4 ft zL = 2 ft

(e) Click Done to update the block and close the panel.

(f) Click icon in the object toolbar.

(g) Display the Openings edit panel by double clicking opening.1 in the Model
manager window.

(h) In the Info tab, enter hdrack1-flow in the Name field and HDRACKs in the
Groups field and click Update.

(i) In the Geometry tab, select Recirc as the Type, Plane to Y-Z, and enter
the following coordinates for the Supply section of the recirculation opening
hdrack1-flow. Click Update to save your changes.

xS = 22 ft xL = ----

yS = 1.5 ft yL = 7 ft
zS = 4 ft zL = 2 ft

(j) In the Geometry tab, select the Plane to be Y-Z, and enter the following coor-
dinates for the Extract section of the recirculation opening hdrack1-flow.

xS = 25 ft xL = ----

yS = 1.5 ft yL = 7 ft
zS = 4 ft zL = 2 ft

(k) In the Properties tab, enter a volumetric flow rate of 1000 cfm and a heat input
of 7000 W as shown below.
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Figure 5.21: The hdrack1-flow Properties Tab
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(l) Click Done to update the opening and close the panel.
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9. Create a row of 11 high density server racks.

(a) Right click on the group HDRACKS to display the context menu.

(b) Select Copy group to display the Copy group HDRACKs panel.

(c) Set the Number of copies to 10.

(d) Check the Group name option and enter HDRACKs in the Groups name field.

(e) Check the Translate option and set the Z offset to 2 ft.

(f) Click Apply. The display will be updated to show the row of 11 racks.

(g) Click Done to close the panel.

(h) Save the project using File−→Save Project.

Figure 5.22: 11 High Density Server Racks in the Graphics Display Window
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10. Create a second row of high density server racks.

(a) Right click on the group HDRACKS to display the context menu.

(b) Select Copy group to display the Copy group HDRACKs panel.

(c) Set the Number of copies to 1.

(d) Check the Group name option and enter HDRACKs in the Group name field.

(e) Check the Rotate option and set the Axis to the Y Axis and the Degrees to 180.

(f) Check the Translate option and set the X offset to 7 ft.

(g) Click Apply. The display will be updated to show the additional row of racks.

(h) Click Done to close the panel.

(i) Save the project using File−→Save project.
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11. Create a perforated floor tile.

(a) Click icon in the object toolbar.

Airpak will create a new vent in the center of the room. you will need to change
the size and orientation of the vent and its location within the room.

(b) Display the Vents edit panel by double clicking vent.1 in the Model manager
window.

(c) In the Info tab, enter tile-planar in the Name field and TILE-PLANAR in the
Groups field and click Update.

(d) In the Geometry tab, change the Plane to X-Z and enter the following coordi-
nates for the vent tile-planar.

xS = 11 ft xL = 2 ft
yS = 1.5 ft yL = ----

zS = 4 ft zL = 2 ft

(e) In the Properties tab, change the vent type to Internal and enter a Free area
ratio of 0.35.
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Figure 5.23: The tile-planar Panel (Properties Tab)
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(f) Click Done to update the vent and close the panel.
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12. Create a row of 11 perforated floor tiles.

(a) Right click on the group TILE-PLANAR to display the context menu.

(b) Select Copy group to display the Copy group TILE-PLANAR panel.

(c) Set the Number of copies to 10.

(d) Check the Group name option and enter TILE-PLANAR in the Group name field.

(e) Check the Translate option and set the Z offset to 2 ft.

(f) Click Apply. The display will be updated to show the complete row of perfo-
rated floor tiles.

(g) Click Done to close the panel.

(h) Save the project using File−→Save Project.

Figure 5.24: 11 Perforated Floor Tiles in the Graphics Display Window
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13. Create a second row of 11 perforated floor tiles.

(a) Right click on the group TILE-PLANAR to display the context menu.

(b) Select Copy group to display the Copy group TILE-PLANAR panel.

(c) Set the Number of copies to to 1.

(d) Check the Group name option and enter TILE-PLANAR in the Group name field.

(e) Check the Translate option and set the X offset to 2 ft.

(f) Click Apply. The display will be updated to show the complete row of perfo-
rated floor tiles.

(g) Click Done to close the panel.

(h) Save the project using File−→Save Project.

Figure 5.25: Second Row of 11 Perforated Floor Tiles in the Graphics Display Window
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14. Create two additional rows of 11 perforated floor tiles.

(a) Right click on the group TILE-PLANAR to display the context menu.

(b) Select Copy group to display the Copy group TILE-PLANAR panel.

(c) Set the Number of copies to 1.

(d) Check the Group name option and enter TILE-PLANAR in the Group name field.

(e) Check the Translate option and set the X offset to 14 ft.

(f) Click Apply. The display will be updated to show the complete rows of perfo-
rated floor tiles.

(g) Click Done to close the panel.

(h) Save the project using File−→Save project.

Figure 5.26: Additional Rows of 11 Perforated Floor Tiles
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15. Create a fluid zone below the perforated floor tile.

Perforated floor tiles used in datacenters typically have some thickness, due to
which, the flow from the underfloor plenum gets straightened out in the vertical
axial (Y in this case) direction, before it enters the main datacenter space.

(a) Click icon in the object toolbar.

Airpak will create a new resistance in the center of the room. You will need to
change the size of the resistance and its location within the room.

(b) Display the Resistances edit panel by double clicking resistance.1 in the
Model manager window.

(c) In the Info tab, enter tile-vol in the Name field and TILE-VOL in the Groups
field and click Update.

(d) In the Geometry tab, enter the following coordinates for the 3D resistance
tile-vol.

xS = 11 ft xL = 2 ft
yS = 1.5 ft yL = -0.3 ft

zS = 4 ft zL = 2 ft

(e) In the Properties tab, enter the loss coefficient or 100 in the X direction
quadratic and the Z direction quadratic fields as shown below.
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(f) Click Done to update the resistance and close the panel.

Figure 5.27: tile-vol in the Graphics Display Window
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(g) Set the object-specific meshing parameters for the resistance tile-vol.

i. Open the Mesh Control panel using the Model menu and clicking on Gen-
erate Mesh.

ii. Check the Object params option and click Edit to open the Per-object
meshing parameters panel.

iii. Select the resistance tile-vol from the list and check the Use per-object
parameters option.

iv. Specify 4 for X count and Z count and 3 for the Y count under Requested.

Figure 5.28: Per-Object Meshing Parameters for tile-vol

v. Click Done to close the Per-object meshing parameters panel.

vi. Click Close to close the Mesh control panel.
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16. Create a row of 11 resistances.

(a) Right click on the group comTILE-VOL to display the context menu.

(b) Select Copy group to display the Copy group TILE-VOL panel.

(c) Set the Number of copies to 10.

(d) Check the Group name option and enter TILE-VOL in the Group name field.

(e) Check the Translate option and set the Z offset to 2 ft.

(f) Click Apply. The display will be updated to show the complete row of resis-
tances.

(g) Click Done to close the panel.

(h) Save the project using File−→Save Project.

Figure 5.29: A Row of 11 Resistances in the Graphics Display Window
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17. Create a second row of 11 resistances.

(a) Right click on the group TILE-VOL to display the context menu.

(b) Select Copy group to display the Copy group TILE-VOL panel.

(c) Set the Number of copies to 1.

(d) Check the Group name option and enter TILE-VOL in the Group name field.

(e) Check the Translate option and set the X offset to 2 ft.

(f) Click Apply. The display will be updated to show the complete rows of resis-
tances.

(g) Click Done to close the panel.

(h) Save the project using File−→Save project.

Figure 5.30: Second Row of Resistances in the Graphics Display Window
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18. Create two additional rows of 11 resistances.

(a) Right click on the group TILE-VOL to display the context menu.

(b) Select Copy group to display the Copy group TILE-VOL panel.

(c) Set the Number of copies to 1.

(d) Check the Group name option and enter TILE-VOL in the Group name field.

(e) Check the Translate option and set the X offset to 14 ft.

(f) Click Apply. The display will be updated to show the complete rows of resis-
tances.

(g) Click Done to close the panel.

(h) Save the project using File−→Save Project.

Figure 5.31: Additional Rows of 11 Resistances in the Graphics Display Window
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19. Create the ceiling plenum.

(a) Click icon in the object toolbar.

(b) Display the Partitions edit panel by double clicking partition.1 in the Model
manager window.

(c) In the Info tab, enter ceiling plenum in the Name field and click Update.

(d) In the Geometry tab, change the Plane to X-Z and enter the following coordi-
nates for the partition ceilingplenum.

xS = 0 ft xL = 40 ft
yS = 10 ft yL = ----

zS = 0 ft zL = 30 ft

(e) Click Done to update the partition and close the panel.
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20. Create a return grille.

(a) Click icon in the object toolbar.

(b) Display the Vents edit panel by double clicking vent.1 in the Model manager
window.

(c) In the Info tab, enter ceiling-return in the Name field and CEILING-RETURN

in the Groups field and click Update.

(d) In the Geometry tab, change the Plane to X-Z and enter the following coordi-
nates for the vent ceiling-return.

xS = 33 ft xL = 2 ft
yS = 10 ft yL = ----

zS = 4 ft zL = 4 ft

(e) In the Properties tab, change the Vent type to Internal and enter a Free area
ratio of 0.5.

(f) Click Done to update the vent and close the panel.

Figure 5.32: ceiling-return in the Graphics Display Window

c© Fluent Inc. May 16, 2007 5-49



High Density Datacenter Cooling

21. Create a row of 3 return grilles.

(a) Right click on the group CEILING-RETURN to display the context menu.

(b) Select Copy group to display the Copy group CEILING-RETURN panel.

(c) Set the Number of copies to 2.

(d) Check the Group name option and enter CEILING-RETURN in the Group name
field.

(e) Check the Translate option and set the Z offset to 9 ft.

(f) Click Apply. The display will be updated to show the complete row of ceiling
return grilles.

(g) Click Done to close the panel.

Figure 5.33: A Row of 3 Return Grilles
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22. Create a second row of 3 return grilles.

(a) Right click on the group CEILING-RETURN to display the context menu.

(b) Select Copy group to display the Copy group CEILING-RETURN panel.

(c) Set the Number of copies to 1.

(d) Check the Group name option and enter CEILING-RETURN in the Groups name
field.

(e) Check the Translate option and set the X offset to -14 ft.

(f) Click Apply. The display will be updated to show the complete row of ceiling
return grilles.

(g) Click Done to close the panel.
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23. Create two more return grilles.

(a) Click icon in the object toolbar.

(b) Display the Vents edit panel by double clicking vent.1 in the Model manager
window.

(c) In the Info tab, enter ceiling-return-crac1 in the Name field and CEILING-RETURN

in the Group field and click Update.

(d) In the Geometry tab, change the Plane to X-Z and enter the following coordi-
nates for the vent ceiling-return-crac1.

xS = 0 ft xL = 2 ft
yS = 10 ft yL = ----

zS = 8 ft zL = 4 ft

(e) In the Properties tab, change the Vent type to Internal and enter a Free area
ratio of 0.5.

(f) Click Done to update the vent and close the panel.

Figure 5.34: Return Grilles (ceiling-return-crac1) in the Graphics Display Window
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(g) Right click the vent ceiling-return-crac1 from the Model manager window to
open the context menu and select Copy object to open the Copy vent ceiling-
return-crac1 panel.

(h) Set the Number of copies to 1.

(i) Check the Group name option and enter CEILING-RETURN in the Group name
field.

(j) Check the Translate option and set the Z offset to 10 ft.

(k) Click Apply. The display will be uploaded to show the 8th ceiling return vent.

(l) Rename ceiling-return-crac1.1 to ceiling-return-crac2.

(m) Click Done to close the panel.
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(n) Set the object-specific meshing parameters for the ceiling return grilles.

i. Open the Mesh Control panel using the Model menu and clicking on Gen-
erate Mesh.

ii. Check the Object params option and click Edit to open the Per-object
meshing parameters panel.

iii. Hold down the <Ctrl> key and select the ceiling return grilles from the list
as shown in Figure 5.35 and check the Use per-object parameters option.

iv. Specify 4 for X count and Z count under Requested.

Figure 5.35: Ceiling Return Grilles Object-Specific Meshing Parmeters

v. Click Done to close the Per-object meshing parameters panel.

vi. Click Close to close the Mesh control panel.
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24. Create a PDU.

(a) Click icon in the object toolbar.

(b) Display the Blocks edit panel by double clicking block.1 in the Model manager
window.

(c) In the Info tab, enter pdu in the Name field and PDU in the Groups field and
click Update.

(d) In the Geometry tab, enter the following coordinates for the block pdu.

xS = 11 ft xL = 4 ft
yS = 1.5 ft yL = 4 ft

zS = 0 ft zL = 2 ft

(e) In the Properties tab, change the block type to Fluid, enter 3600 W in the
Total Power field, check Enabled under Surface specification, check Individual
sides and click Edit. Turn on the Thermal properties option for all the sides of
the block - Min X, Max X, Min Y, Max Y, Min Z and Max Z.

(f) Click Done to update the block and close the panel.

(g) Click icon in the object toolbar.

(h) Display the Openings edit panel by double clicking on opening.1 in the Model
manager window.

(i) In the Info tab, enter pdu-top in the Name field and PDU in the Groups field
and click Update.

(j) In the Geometry tab, change the Plane to X-Z and enter the following coordi-
nates for the free opening pdu-top.

xS = 11 ft xL = 4 ft
yS = 5.5 ft yL = ---- ft

zS = 0 ft zL = 2 ft

(k) Click Done to update the opening and close the panel.

(l) Click icon in the object toolbar.

(m) Display the Vents edit panel by double clicking on vent.1 in the Model manager
window.

(n) In the Info tab, enter pdu-bottom in the Name field and PDU in the Groups
field and click Update.

(o) In the Geometry tab, change the plane to X-Z and enter the following coordi-
nates for the vent pdu-bottom.

xS = 11 ft xL = 4 ft
yS = 1.5 ft yL = ---- ft

zS = 0 ft zL = 2 ft
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(p) In the Properties tab, change the Vent type to Internal and enter 0.25 for the
Free area ratio.

(q) Click Done to update the opening and close the panel.
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(r) Set the object-specific meshing parameters for pdu-bottom and pdu-top.

• Open the Mesh Control panel using the Model menu and clicking on Gen-
erate Mesh.

• Check the Object params option and click Edit to open the Per-object
meshing parameters panel.

• Hold down the <Ctrl> key and select the pdu-top and pdu-bottom from
the list and check the Use per-object parameters option.

• Specify 4 for X count and Z count under Requested.

• Click Done to close the Per-object meshing parameters panel.

• Click Close to close the Mesh control panel.

25. Create the second PDU.

(a) Right click on the group PDU to display the context menu.

(b) Select Copy group to display the Copy group PDU panel.

(c) Set the Number of copies to 1.

(d) Check the Group name option and enter PDU in the Group name field.

(e) Check the Translate option and set the X offset to 14 ft and the Z offset to 28
ft.

(f) Click Apply. The display will be updated to show the second PDU.

(g) Click Done to close the panel.

(h) Save the project using File−→Save project.
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26. Create blockages.

(a) Click icon in the object toolbar.

(b) Display the Blocks edit panel by double clicking block.1 in the Model manager
window.

(c) In the Info tab, enter piping in the Name field and BLOCKAGE in the Groups
field and click Update.

(d) In the Geometry tab, enter the following coordinates for the block piping.

xS = 0 ft xL = 1 ft
yS = 0 ft yL = 1 ft
zS = 0 ft zL = 30 ft

(e) Click Done to update the block and close the panel.
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(f) Click icon in the object toolbar.

(g) Display the Blocks edit panel by double clicking block.1 in the Model manager
window.

(h) In the Info tab, enter blockage1 in the Name field and BLOCKAGE in the Groups
field and click Update.

(i) In the Geometry tab, enter the following coordinates for the block blockage1.

xS = 36 ft xL = 4 ft
yS = 0 ft yL = 12 ft

zS = 22 ft zL = 8 ft

(j) Click Done to update the block and close the panel.
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27. Create columns.

(a) Click icon in the object toolbar.

(b) Display the Blocks edit panel by double clicking block.1 in the Model manager
window.

(c) In the Info tab, enter column1 in the Name field and COLUMNS in the Groups
field and click Update.

(d) In the Geometry tab, enter the following coordinates for the block column1.

xS = 20 ft xL = 1 ft
yS = 0 ft yL = 12 ft
zS = 0 ft zL = 1 ft

(e) Click Done to update the block and close the panel.
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(f) Click icon in the object toolbar.

(g) Display the Blocks edit panel by double clicking block.1 in the Model manager
window.

(h) In the Info tab, enter column2 in the Name field and COLUMNS in the Groups
field and click Update.

(i) In the Geometry tab, enter the following coordinates for the block column2.

xS = 20 ft xL = 1 ft
yS = 0 ft yL = 12 ft

zS = 20 ft zL = 1 ft

(j) Click Done to update the block and close the panel.
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28. Create 2 cabletrays.

(a) Click icon in the object toolbar.

(b) Display the Blocks edit panel by double clicking block.1 in the Model manager
window.

(c) In the Info tab, enter cabletray1 in the Name field and CABLETRAYS in the
Groups field and click Update.

(d) In the Geometry tab, enter the following coordinates for the block cabletray1.

xS = 11 ft xL = -2 ft
yS = 0.5 ft yL = 0.5 ft

zS = 2 ft zL = 24 ft

(e) Click Done to update the block and close the panel.
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(f) Right click on the group CABLETRAYS to display the context menu.

(g) Select Copy group to display the Copy group CABLETRAYS panel.

(h) Set the Number of copies to 1.

(i) Check the Group name option and enter CABLETRAYS in the Group name field.

(j) Check the Translate option and set the X offset to 6 ft.

(k) Click Apply. The display will be updated to show the second cabletray.
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29. Create 2 more cabletrays.

(a) Right click on the group CABLETRAYS to display the context menu.

(b) Select Copy group to display the Copy group CABLETRAYS panel.

(c) Set the Number of copies to 1.

(d) Check the Group name option and enter CABLETRAYS in the Group name field.

(e) Check the Translate option and set the X offset to 14 ft.

(f) Click Apply. The display will be updated to show the remaining cabletrays.

(g) Click Done to close the panel.

(h) Save the project using File−→Save project.

(i) The completed model will look like Figure 5.36.

Figure 5.36: Completed Model
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Step 3: Generate a Mesh
Some object specific refinement settings have already been made while building the model.

1. Generate a fine mesh.

(a) Click on the icon.

(b) Set the Max X, May Y, and Max Z sizes to 2 ft, 0.5 ft, and 1 ft respectively.

(c) Set the Minimum gap in X, Y, and Z to 1 in, 0.36 in and 1 in respectively.

(d) Click Generate Mesh

The panel will be updated with the information with regard to the number of
elements and the number of nodes. Related information will also be printed in
the Message window.
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Figure 5.37: The Mesh Control Panel
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(e) Click Display Mesh and use the Cut Plane option to review the mesh in all
three coordinate planes.

Figure 5.38: Displaying Mesh

i There is no mesh for the Min Y and Max Y sides of the pdu block because
the pdu-top opening and the pdu-bottom vent take precedence over the
block sides for meshing.
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(f) Click Quality and access the quality of the mesh by reviewing the face align-
ment, quality and volume quality metrics.

Figure 5.39: The Quality Tab of the Mesh Control Panel
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Step 4: Calculate a Solution

1. Increase the number of iterations to 1000.

Solve−→Settings−→Basic
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2. Start the calculation.

Solve−→Run Solution

(a) Keep the default settings in the Solve panel.

Solve−→Settings−→Basic

(b) Click Start solution to start the solver.

Airpak will begin to calculate a solution for the model, and a separate window
will open where the solver will print the numerical values of the residuals.
Airpak will also open the Monitor graphics display and control window, where
it will display the convergence history for the calculation.

If you do not want to wait for the calculation to finish, you can save time by
reading in the results provided in the tutorials directory and then following
the instructions (in the next step of this tutorial) for examining the results.
See the preface (Using This Manual) for details.

Upon completion of the calculation, your residual plot will look similar to
Figure 5.40. Note that the actual values of the residuals may differ slightly
on different machines, so your plot may not look exactly the same as Fig-
ure 5.40. In the window where the residual values are printed, the calculation
will continue after the residual plot stops, as the mean age of air calculation
is completed.

To get a more accurate solution, it may be necessary to continue the calcula-
tion until all residual plots level off. You can do this by reducing the conver-
gence criteria for the flow and energy equations in the Solver setup panel and
restarting the calculation. See the User’s Guide for details about restarting
the calculation from an existing solution.
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Figure 5.40: Residuals Plot
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Step 5: Examine the Results
The objective of this exercise is to consider the airflow patterns and identify problem areas
such as hot spots, stagnant zones, and recirculation zones through out the datacenter.
You will accomplish this by examining the solution using Airpak’s graphical postprocessing
tools.

1. Load the solution for postprocessing.

Post−→Load Solution ID to open the version selection panel. Select datacenter00
and click Okay.

2. Switch the visibility of the object names to the Selected option.

View−→Display−→Object names−→Selected

3. Click icon from the Orient toolbar to show an isometric view of the room
scaled to fit the graphics window.

4. Display contours of temperature on the CRACs, Racks, and PDUs.

Post−→Object face

(a) In the face Name field, enter the name surface-temp-contours.

(b) In the Object drop-down list, hold down the <Ctrl> key, select the groups
CRAC, RACKs, HDRACKs and PDU and click Accept.

(c) Check the Show contours option and click Create on the Object face panel. The
display will be updated to show the contours of temperature on the CRAC
units, Racks and the PDUs as shown in Figure 5.41.

(d) Click Done on the Object face panel to update and close the panel.
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Figure 5.41: Contours of Temperature Display
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(e) Modify the color legend precision to 2 using the float option as shown in the
figure below.

Figure 5.42: The Preferences Panel

(f) Click on This project to confirm this change for the existing project only and
close the Preferences panel.
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5. Display contours of temperature on a plane cut in all 3 coordinate planes.

(a) Right click surface-temp-contours under Post-processing in the Model man-
ager window and make the object face inactive by unchecking Active from the
list.

(b) Open the Plane cut edit panel using Post−→Plane cut.

(c) In the face Name field, enter the name plane-temp-contours.

(d) Check the Show contours option and click Create on the Plane cut panel. The
display will be updated to show the contours of temperature on the XY plane
in the center of the datacenter as shown in Figure 5.43.

Figure 5.43: Contours of Temperature Display
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(e) Check the Loop mode option and click Animate to traverse the plane-temp-contours
from the min Z extent of the datacenter to the max Z extent of the datacenter.

(f) Click Interrupt on the progress bar to return to the Plane cut panel.

(g) Repeat the above procedure for plane cuts in the YZ plane and the XZ plane
by changing the Set position to X plane through center and Y plane through
center respectively.

(h) Click Done on the Object face panel to update and close the panel.

(i) Save the project using File−→Save project.

6. Display contours of temperature on an isosurface.

(a) Right click plane-temp-contours under Post-processing in the Model manager
window and make the plane cut inactive by unchecking Active from the list.

(b) Open the Isosurface edit panel using Post−→Isosurface.

(c) Enter iso-temp in the Name field.

(d) Enter 90 in the Value field.

(e) Check the Show Contours option and click Create.

Figure 5.44: The Isosurface Panel

c© Fluent Inc. May 16, 2007 5-77



High Density Datacenter Cooling

(f) The display will be updated to show the isosusrface of 90 degrees F in the
datacenter space.

(g) Enter 95 in the Start field, 85 in the End field and 10 in the Steps field under
Animate on the Isosurface panel.

(h) Check the Loop mode option.

(i) Click Animate to visualize the isosurfaces of temperature within the range of
95 F to 85 F.

Figure 5.45: Setting the Temperature Range in the Isosurface Panel

(j) Click Interrupt on the progress bar to return to the Isosurface panel.

(k) Click Done to update and close the panel.

5-78 c© Fluent Inc. May 16, 2007



High Density Datacenter Cooling

7. Display airflow patterns in the datacenter.

(a) Right click iso-temp under Post-processing in the Model manager window and
make the isosurface inactive by unchecking Active from the list.

(b) Change the orientation to the side view using Orient−→Orient Negative Z and
resize the display using Orient−→Scale to fit.

(c) Open the Object face panel using Post−→Object face.

(d) Enter airflow in the Name field.

(e) Hold down the <Ctrl> key, select the groups CEILING-RETURN, RACKs, HDRACKs,
PDU and TILE-PLANAR from the Object list and click Accept.

Figure 5.46: The Object face Panel

(f) Check the Show particles option and click Parameters to open the Object face
particles panel.

(g) Set the Display options to Mesh points.

(h) Set the End time under Particle options to 5.

(i) Check the Loop mode option under Animation and set the number of steps to
50.

(j) Click Apply to display the airflow patterns in datacenter.

Note: Airpak will take a few minutes to generate the airflow patterns.
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Figure 5.47: Airflow Patterns
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(k) Click Animate to visualize the airflow patterns in the datacenter in a transient
manner.

(l) Change the orientation to the isometric view using Orient−→Isometric

(m) Click Animate to visualize the airflow patterns in the datacenter ina transient
manner.

(n) Change the orientation to the plane view using Orient−→Orient Negative Y

(o) Click Animate to visualize the airflow patterns in the datacenter in a transient
manner.

(p) Click Done to update and close the Object face properties panel.

(q) Click Done to update and close the Object face panel.

(r) Right click airflow under Post-processing in the Model manager window and
make the particle traces inactive by unchecking Active from the list.

8. Report the volumetric flow rate distribution at perforated floor tiles.

(a) Open the Define summary report using Report−→Summary Report

(b) Click New to get a new field to define the Summary report.

Figure 5.48: Summary Report
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(c) Select the group TILE-PLANAR under Objects and click Accept.

(d) Select Volume Flow under Value and deselect the Comb option.

Figure 5.49: Define Summary Report

(e) Click Write to display the summary report on the screen.

Figure 5.50: Report Summary Data

(f) Click Done to close the Report summary data panel.

(g) Click Close to close the Define summary report panel.

(h) Save the project using File−→Save project.
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